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INTRO TO Studio in Art for Broadcasting 

 

Intro to Studio in Art for Broadcasting is an introductory level, application-based program 

designed to assist students in the navigation and comprehensive understanding of the functions 

and techniques in Adobe Photoshop, Illustrator and InDesign as they are used in a Broadcasting 

context.  Students will be able to develop image-processing techniques such as manipulating 

rasterized images and designing vector graphics in order to create artwork specific to the needs 

for the Broadcasting program. This course will provide a foundation for students to excel in a 

myriad of disciplines including graphic design, digital photography and video editing.  This will 

enable them to use these skills in future broadcasting courses as well as a variety of educational 

and design related career paths. 

This is a half year, half credit course paired with a half year course MUSIC for Broadcasting to fulfill 

their high school art requirement.   

This course is only open to students enrolled in the Broadcasting program.   

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

4 
 

 

 

Curriculum Overview 

Unit 1 – Navigating the Mac, file types, DPI 

Unit  2 – Intro to Photoshop, Elements & Principles, &  intro to a “Spec sheet” 

Unit  3 –  Photography - Composition, Lighting, & Portraiture  

Unit 4 – Intro to Layers:  Title Screen for Audio Report 

Unit 5 – Intro to Illustrator:  Logos,  Lower ⅓, Typography and the  Infographic 
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UNIT I: NAVIGATING THE MAC (appx. 2 days) 

This unit will go through how to login into your Mac, use the launch pad to find applications and 

the trash bin as well as file types, folders, renaming and organizing files.  Saving on the computer 

or on external devices such as flash drives and hard drives and sharing files on google cloud will be 

also be introduced in the unit. 

 

Objective 1- The Mac 

 

Log-
In 

Allows access to the Mac. There is no individual account protected by a password, all files can be viewed, 
accessed, and edited by anyone who uses the machine. 
● Click on “Student” icon 
● Hit Return 

The 
Dock  

The Dock is the bar of icons that sits at the bottom of your screen. It provides easy access to many of the 
apps that come with your Mac (Finder, Launchpad, Mail, Safari, Calendar). You can also add your own 
apps, documents and folders to the Dock. 
● Scroll over an icon, it will enlarge slightly and the name will appear above it. 
● Click to open 
●  To force quit, hover over icon, hold down left mouse key and scroll down to “Force Quit”, hold until 
application closes  

Launc
h pad 

Launchpad helps you find, organize and easily open all of your Apps. By default, items in are arranged in 
alphabetical order. You can re-arrange icons by dragging them in the order you want. If there's not enough 
room to show all of your apps on one screen, Launchpad creates multiple pages. The dots at the bottom of 
the Launchpad screen show you how many pages of apps there are, and which page you are currently 
viewing. 
● Click on Launchpad (Rocketship) icon in the Dock 
● Locate App icon and click to open 
● If icon is not located on present page, use right arrow key to scroll to next screen, or click the next 
dot on the bottom of the screen.  
● Click anywhere (except on an icon) to exit Launchpad. 
 

Tras
h Bin 

The Trash is where any deleted files go. They are kept here so that if you later change your mind, the files 
can be rescued. 
● Drag and drop a file on the trash icon in the dock 
● Control-click on a file and select "Move to Trash" from the menu 
● Select a file or files and choose "File > Move to Trash" from the menu bar 
● Empty by clicking on icon and hitting “Empty”, this will permanently delete the files from the 
computer. 
● To restore a file, click and drag it onto the Desktop of into desired location.  
● If there is something in the Trash Bin, the icon will have an image of crumpled paper in it, when the 
Trash Bin is emptied, the paper will disappear.  

 

http://guides.macrumors.com/Drag_and_drop
http://guides.macrumors.com/Control-click
http://guides.macrumors.com/menu_bar
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Suggested Activities/ Exercises:     
● Practice using Launchpad 
● Practice moving and recovering items from Trash Bin 

 

 Objective 2- Saving and Sharing Documents 

External 
Devices 

Since Macs do not have a password protected log-in, it is necessary for students save their work to a 
secure location. To Quit an external device, drag icon to the Trash Bin. When icon disappears, it is safe to 
remove the device from the computer.  

● Flash Drive 
● External Hard Drive 

Google 
Drive  

Students may save their documents in their school provided Google drive.  This will also allow them to 
access their files from any computer in any location and share their files with their teacher and other 
students. 

● Save file onto desktop. 
● Open Google drive 
●  Drag file into “My Drive”  

Email Students can email work to themselves using their gmail account. 
● Save file onto desktop 
● Open gmail, attach file to message 

 

Suggested Activities/ Exercises:     
● Practice saving files to a Flash or External Hard Drive 
● Practice saving documents to Google drive and sharing with others 
● Practice emailing files via attachment 

 

Objective 3- File Types and Organization 

Document Extension Files 

● .PSD (Adobe Photoshop Document) layered image file  

.AI (Adobe Illustrator Artwork) single-page vector-based drawings 

-can only be opened on a computer with compatible Adobe software  

-large file size which is great for print but not storage space  

 

Image-editing Extension Files 

.PNG (Public Network Graphic) 
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-raster graphics file format that works with lossless data compression to reduce the file size without 

degrading the visual quality.  This is good for saving on portable devices where storage space is limited 

-designed for transferring images on the Internet and great for obtaining images with no background 

(for web layouts) 

-not for professional-quality print graphics because it does not support non RGB color spaces such as 

CMYK  

-more commonly used over .GIF (Graphic Interchange Format) files  

.TIFF (Tagged Image File Format) 
-computer file format for storing raster graphics images and use for editing since, like a .PNG, it does 

not reduce the quality of an image 

-widely supported by image-   manipulation applications, by publishing and page layout applications, 

and by  scanning, faxing, word processing, optical character recognition and other  applications 

-not recommended for small file or a web-friendly format 

.JPG/.JPEG (Joint Photographic Experts Group) 
-most commonly used method of lossy compression (degradation of image quality) for digital images, 

particularly for digital photography 

 

Figure 1 Low Compression (large file) = High Quality Figure 2 High Compression (small file) = Low Quality 

 

-go to format for online photos because it supports a full spectrum of colors and most universally-accepted 

format for almost all devices and programs  

-great for displaying online  

*GIF, PNG, JPEG, and TIFF files are designed for different graphic needs 

● NEW! Smart Objects 
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-layers that contain image data from raster or vector images, such as Photoshop or Illustrator files. Smart 

Objects preserve an image's source content with all its original characteristics, enabling you to perform non 

destructive editing to the layer. 

Sharing/Print Extension Files 

● .PDF (Acrobat -Portable Document Format) 

-used for viewing and printing only and cannot be edited  

-best used for preserving original format when opening a document in a different version, edition or program  
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UNIT II – INTRO TO PHOTOSHOP , ELEMENTS & 

PRINCIPLES OF DESIGN, SPEC SHEETS 

(appx. 8-10 days) 

Photoshop is an image editing software program that allows users to manipulate, stylize, crop, 

resize, and correct color on digital photos.  Popularly used by professional photographers and 

graphic designers, Photoshop optimizes photographs and provides tools that assist in the creation 

of digital artwork. 

Students will learn how to open and start documents, the difference between rasterized and vector 

images and how to identify royalty free art and internet copyright laws.  Students will also 

understand the design aspects of taking a photo using a camera or phone as well as how to scan and 

obtain a photo on the internet. 

This unit will also cover the tools, menu commands, and panel-based features to open and edit your 

digital images in the Photoshop workspace. 

 

What is Adobe Photoshop? 

Objective 1- Acquiring an Image 

● Creating and saving a Photoshop document  

● Discuss rasterized vs. vector images 

● Internet 

-Royalty free art and copyright infringement laws 
-Size, resolution, search options  

● Digital camera; phone 

● Discuss Iphone camera settings High Efficiency (.heic) vs. Most Compatible (.jpg) ←  

● Scanning 

 

 

Objective 2 - Photoshop Workspace  

Menu Bar: Located on the top of Photoshop screen and contains most Photoshop commands used 

for any document  

Tools Techniques 

File Used to create and open Photoshop documents; place an 

image or photograph; save and print documents; exit 
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Photoshop  

Edit Allows users to undo; cut/copy/paste images or shapes; 

apply fill and stroke; resize/distort/align images or shapes  

Image Used to make adjustments to light and color; change 

image or canvas size; rotate/crop/trim an image  

Layer Allows users to add/duplicate/delete layers; create 

layer/vector/clipping masks; organizes layers by 

grouping/hiding/arranging/locking/merging/flatten 

Select Controls quick select/deselect/inverse selection 

commands to images, layers or masks   

Filter Contains commands to manipulate or stylize images 

*filter gallery allows users to preview all filters before 

applying 

3D/Analysis  Allows users to add 3D effects on images or layers 

View  Access to zoom in and out/full screen functions, rulers, 

guides and snap to guide options  

Window Contains multi-view functions that assist with combining 

multiple documents; opens any panel or properties 

window  

 

Tools Panel Overview: image-editing icons on the left side of the Photoshop program (keyboard 

shortcut commands are listed in parenthesis) 

Tools Techniques 

Selection tools 

Move (Shift-V) 

 

 

Marquee (Shift-M) 

 

 

Allows user to move elements on selected layer; Holding 

control/command on keyboard enables user to select an 

object on a different layer  

 

Makes geometric shape selections; Works best with 

creating graphic; cut out functions can be changed on the 

option bar  
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Lasso (Shift-L) 

 

 

Quick Selection (Shift-W) 

 

Use magnetic lasso for the most control; Best used when 

elements of an image contrasts sharply with the 

background 

 

Magic wand tool works best with solid color images; Quick 

select allows users to increase or decrease selected area 

*Both the tolerance and the brush size can be adjusted on 

the option bar  

Crop and Slice tools (Shift-C) Provides crop lines to adjust desired size *Holding shift 

will constrain proportion; Slice tool can cut rectangular 

sections from images that can be later copied onto another 

document  

Measuring tools (Shift-I) Allows user to copy a specific color from any image using 

the eyedropper tool  

Retouching tools  

Spot Healing (Shift-J) 

 

Clone Stamp (Shift-S) 

 

 

Patch  

 

 

Eraser (Shift-E) 

 

 

Blur 

 

Copies pixels from one area of an image to another to 

correct defects; recognizes texture and lighting making 

modification more convincing  

 

Cleans up flaws in an image by copying information from 

one area to another; application works best with a soft 

brush and low opacity   

 

Recognizes a whole section of unflawed pixels to correct a 

larger defected area; eliminates differences in color and 

texture   

 

Separates elements from their backgrounds; Magic eraser 

controls and deletes groups of similar pixels, tolerance can 

be adjusted accordingly  

 

Blur and sharpen tools allow users to emphasize or de-

emphasize; smudge tool blends pixels simulating as if a 

finger is dragging through wet paint  
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Dodge (Shift-O) 

 

Can brighten or darken specific areas of an image; dodge 

lightens/burn darkens; brush type and exposure can be 

adjusted on the options bar 

 

Painting tools  

Brush (Shift-B) 

History Brush (Shift-Y) 

 

 

Gradient (Shift-G) 

 

Applies colors with many different types of brush styles; 

assists with multiple Photoshop editing options  

*Users can also create custom brush styles and save them 

for later use 

 

Transitions one color into another giving the image a 

shadow or 3D effect 

Drawing and Type tools 

Pen (Shift-P) 

 

Type (Shift-T) 

 

Path Selection (Shift-A) 

 

Rectangle (Shift-U) 

 

Draws an angular or curved path that can either be typed 
on or turned into a shape  

 

Can select any size or font in the options bar; specific type 
and letters can be edited in Character Panel 

 

Allows user to move specific anchor points on a path in 

order to edit shapes, text, objects, etc.  

 

Create any geometric shapes and custom symbols. *Users 

can also create custom shapes and save them for later use 

Navigation tools  

Hand (Shift-H) 

Zoom (Shift-R) 

 

Pans to focus on different areas of an image  

Zooms in and out of canvas area  

Option Bar: Displays controls that let user customize the selected tool from the toolbox providing 

more specific options 

Image Window/Document tabs:  Contains each image the user opens in Photoshop (Can be arranged 
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and combined using window options in the menu bar) 

Panels: Small, free floating windows that give the user access to common commands and resources.  

The essentials panel option is the most common Photoshop format for beginners.  Panel views can 

be edited in the Windows menu bar.  

Panels Techniques 

Layers Creates a history of all created layers as well as quick 

shortcut editing options for all layer related functions; 

also contains channels and paths tabs but are used 

infrequently   

Color Allows user to choose fill and stoke colors and then adjust 

the value and ratio of RGB hues; also contains a swatches 

tab that keeps a history of commonly used and newly 

created colors for quick select 

Adjustments Provides quick selection options for light and color 

adjustments; also contains style tab that applies a style to 

the background of a photo 

 

 

Resources: 

Suggested Tutorials: What is Photoshop?; Photoshop Workspace 

https://helpx.adobe.com/photoshop/how-to/introduction-work-area.html?set=photoshop--

fundamentals--photoshop-workspace  

https://helpx.adobe.com/photoshop/how-to/introduction-work-area.html?set=photoshop--fundamentals--photoshop-workspace
https://helpx.adobe.com/photoshop/how-to/introduction-work-area.html?set=photoshop--fundamentals--photoshop-workspace
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Objective 3: Reviewing the Elements and Principles of Art/Design 

Students will spend a few days reviewing the elements and principles of art and design.  Followed by 

a brief photography assignment to demonstrate that they understand the concepts.   

The following is an example powerpoint 
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Name:____________________________________ 

Photography Assignment 

 

Task: Use a camera or your smart device to take photographs that represent each of the 

elements and principles assigned. 

 

ZOOM IN!!!!! For the most part, you will have much more interesting photographs if you are 

very close to your subject matter. 

Be Creative….Break the Rules…Take Chances…You are problem solvers. 

 

At home, Upload your images to your own folder in Google Drive. 

 

Elements 
Line 
Shape 
Form 
Space 
Texture 
Color 
Value 
 
Principles 
Balance 
Proportion 
Unity 
Emphasis 
Contrast 
Rhythm 
Movement 
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Objective 4: Learning the “Workflow” for an image 

Workflow: 

Our sequence of processes or steps through which a photo passes from beginning to end. 

1- Open Photoshop- check for workspace (Toolbar, Layers, History) 

2- Open Image 

3- Resize (for easier handling) 

● Image 

● Image Size 

● Document Size 

○  Width/Height 

○  Resolution 

  

4- Color Correct (white balance is your camera’s compensation for the temperature (or color) of the 

light- color balance allows us to correct it) 

● Image 

● Adjustments 

● Color Balance 

● Move the toggle away from what you have too much of 

OR 

● Image 

● Adjustments 

● Photo Filter 

● Work with the different filters in the dropdown menu AND the density toggle to make it look 

more natural 

●  

5- Exposure 

● Image 

● Adjustments 

● Levels (**Always use Input, never output) 

● Adjust the black, grey and white toggles to adjust the exposure of the image. 

● Moving the black right will darken the darks 

● Moving the white left with lighten the lights 
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● Moving the grey toggle left will lighten the midtones; moving it right will lighten the midtones 

  

6- Crop (tool options) 

● Constraints 

Students will then use the “Workflow” to edit the pictures they took for their Elements 

& Principles photography assignment.   

 

Objective 5 - Broadcasting Spec Sheet 

Learn the specific constraints necessary for creating documents for the Broadcasting program 

 

What is a Spec Sheet? 

A Spec Sheet is a list of specifications provided by a client that will let the designer know exactly how 

their graphic/product/footage should be created, saved, and delivered.  

Sample Spec Sheets: 



 

 

 

26 
 

 

 

 

IDENTIFY THE GOALS AND REQUIREMENTS OF THE PROJECT. 

Students will ask questions to get a clear understanding of expectations of the project. 

 

● What is the project: graphics, footage, sound bites, etc? 

● What style of project are you trying to capture? 

● How will the project be used: web and/or print? 

● What is the deadline? 

● Target audience 

● Time, date & location 

● Provide layouts or other visual samples 

● Client contacts: such as in-house art director  

● Shot list and number of required images 
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● Color Pantone # 

● DPI 

● Size Inches vs. Pixels 

● Setting up a document size etc. 

 

Review beginning a NEW document in Photoshop based on the “Specs” of a new project:  
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UNIT III – PHOTOGRAPHY - COMPOSITION, 

LIGHTING, & PORTRAITURE  

(appx. 20 days) 

 

Basic Compositional Guidelines 

Subject Area: Photography  
Title: Basic Compositional Guidelines 
Grade Level:  10th 
Suggested Time Frame: 2-3 classes 
 

Goal: 
Increase student understanding of basic compositional guidelines that create a good photograph. 
 

Learning Objectives: 
Students will learn how to verbally define as well as visually recognize a what constitutes a good 
composition and why. Students will observe examples of good vs. bad compositions and be able 
to identify the qualities of each.   

 
Motivation:  

The lesson will begin with a slideshow of photographs mixed with vocabulary and definitions 
that will explain each different type of composition.  Students will then be allowed to search the 
internet looking for their own examples. 
 
THE ASSIGNMENT:  
 
DIGITAL SCRAPBOOK 
 
“It is important to be able to recognize the compositional guidelines when they are used in other 
people's work before you try to use them in your own work. Do not rely on an internet search to 
pull up photos labeled correctly. Just because you type in leading lines as a search parameter 
does not mean that is what you will get. therefore, simply search for images. Choose the ones 
that appeal to you, then decide which guidelines it uses. It IS possible and common for a photo 
to use more than one guideline. You are looking for photos that have the guideline as the 
dominant force. So a photo that uses rule of thirds, but is really more of a perspective shot, 
should be put into the perspective category.  
 
For each guideline discussed, you will find 5 photos that use that guideline. You should try to 
find photos that appeal to you- not ones that just meet the guidelines. Create a digital photo 
scrapbook and place the photos on pages- label each category!” 
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Procedure:  

● Prepare materials: slideshow of images & definitions, hand out with vocabulary, definitions, 
and directions. 

● Begin lesson with slideshow.   
● Teacher will ask questions to evoke thoughts regarding composition of each photo. 
● Teacher will discuss the compositional guidelines used in each. 
● Teacher will go over expectations of the assignment and review tools and criteria of images. 
● Students will be give ample amount of time to complete assignment. 
● Students will present their own slideshow of images. 

 
 

Vocabulary: 
BASIC COMPOSITIONAL GUIDELINES 
SIMPLICITY 
RULE OF THIRDS 
LEADING LINES 
HORIZON LINES 
FRAMING 
PERSPECTIVE/POINT OF VIEW 
DEPTH OF FIELD 
LOOKING AT THINGS IN A DIFFERENT WAY 
MAN MADE PATTERNS 
NATURAL PATTERNS 

 

 

Lighting 

There's no substitute for good lighting. 

The GIGO principle certainly applies to lighting. The fact is, if you start with grainy, poorly-lit footage, your 

end result will be compromised. No matter what people tell you, it doesn't matter how good your camera and 

editing software may be, if you are a lazy lighter, your productions will suffer. Knowing this, the best thing you 

can do to increase the production quality of your videos is NOT to buy a better camera or a new color-

corrector. The first thing you should do is learn to light. While these five tips can't possibly cover all there is to 

know about lighting, my hope is that they will inspire you to learn to light like the pro that you are. 

#1 - SHOOT A THREE-POINTER  
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Three-point lighting is the time-tested standard for lighting talent for TV and film (Figure 1). 

 

Three-point lighting consists of Key, Fill and 

Back lights. 

Figure 1 

A three-point setup consists of a key, a fill and a back 

light. The key light is typically positioned to the front of 

the subject, slightly to one side. It provides the primary 

source of illumination in this setup and its quality and 

characteristics help to establish the mood of the scene. 

The fill light is less powerful than the key light. It is positioned on the side opposite the key and 

serves to soften (or fill-in) the shadows created by the key light. The back light (or hair light) is 

positioned above and behind the subject so that it casts light on the subject's head and shoulders. 

This adds depth and separates him from the background. Learning and using three-point lighting 

isn't difficult. It will make a huge difference in the look of your footage and in the overall 

professionalism of your productions. If you're not using it, it's time to start. 

#2 - SET THE MOOD WITH SHADOWS  

When a bright key light is positioned close to the camera, the result is "flat" lighting (Figure 2a). 

 

A key light at the 6:00 position creates a flat, "ordinary" look that is 

absent of emotion. This look is often used for lighting news setups. 

Figure 2A 

Flat lighting is emotionally neutral. If you're doing news, this may be fine. But if you want to add 
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emotion, merely flooding your subject with bright, flat, light isn't enough. Lighting can be used to 

move and manipulate shadows to create the illusion of depth on a two-dimensional screen. To add 

depth, position the key light so that it strikes your subject at an angle (Figure 2b). 

 

A key light positioned at the 4:30 (or 7:30) position adds the illusion of depth without being overly 

dramatic. This is the preferred position for the key in most three-point lighting setups.  

Once the key is positioned appropriately, use the fill light to soften its shadows to your liking. 

#3 - SOFTEN UP  

The hardness or softness of a light can be determined by examining the shadows that it casts on your 

subject. A hard light casts a dark shadow with a sharp edge transfer (Figure 3a).  
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Hard Light has a narrow shadow edge 

transfer and a dark, dramatic shadow 

Figure 3A 

Soft light has a wide shadow edge transfer 

and a softer, lighter shadow.  Soft light is 

typically preferred for lighting faces 

Figure 3B 

  

Soft light casts lighter shadows with a wide gradient shadow-edge transfer (Figure 3b). Soft light is 

more flattering to the face than hard light and is preferred in most setups. Hard light can make a 

subject look intense and even wicked. Small, focused lamps cast hard light and shadows. Larger and 

more diffused lamps cast softer light and shadows. You can soften the effect of a light by adjusting its 

distance from the subject or by adding diffusion to spread the light. 

#4 - HANDLE HARD-TO LIGHT PEOPLE  

Some people are inherently more difficult to light than others. The top three problems you'll run into 

are: people wearing glasses, bald heads and dark skin. While the solutions are slightly different, the 

problem is essentially the same: bright reflections and specular highlights that create unattractive, 

glowing, hot-spots. When lighting a person with glasses, lights placed anywhere near the camera 

create specular highlights on the lenses of the subject's specs (Figure 4a). Bald heads are less of a 

problem, but you'll still get small hard light spots across the cranium. When you expose subjects with 

dark complexions properly, you often end up with hot spots on the tip of the nose, forehead, cheeks 

and chin.  
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Lights positioned anywhere near the  

camera will create ugly, distracting 

reflections on the lenses of glasses. 

Figure 4A 

Eliminate specular highlights in spectacles 

by moving lights out to the sides 

and raising them higher on their stands. 

Figure 4B 

For glasses, the solution is to go up and out. Raise your lights higher and position them as far to the 

sides as possible until the reflections are gone (Figure 4b). People with bald heads or dark skin need 

to be lit with very large, very soft lights positioned very close. The goal is to make the specular 

highlight larger than the subject's face, bathing them in soft light. 

#5 - LIGHT THE WHOLE SHOT, NOT JUST THE SUBJECT  

The job doesn't end when your subject is lit. You're not done until you've lit the whole shot. Save a 

light or two for your background. Pinch your barndoors down to create a shaft of light across the 

background or add a gel for a splash of color. Taking a little extra time to dress your set with light 

will greatly improve the look and feel of your shots. 

 

 

 

 



 

 

 

34 
 

 

Lighting for Interviews 

Equipment 

You'll need at least two lights, preferably three. A soft source is best for your subject, a second light 

for the background, and a third for either fill light, hair light, or a side light (variously called "edge" 

light or "rim" light). While you can get away with bouncing your light from an umbrella for your 

main or key, umbrellas tend to scatter light all over the place, making subtlety difficult. A softbox 

will control spill, accept gels, and offer other accessory options. I have a love-hate relationship with 

grids: love to use them, hate to pay for them, but once you do, you'll know where the money went. 

They generally come in 20-, 40- and 60-degree angles. The smaller the number is, the narrower the 

beam will be. A grid will give you a soft, directional source—almost a contradiction when you 

consider the characteristics of most bare light sources. 

 

I'd go for a 16 x 22" box (which fits almost anywhere) or 

a 24 x 32" with a 300-500 watt lamp. Starting position 

should be 45° off axis both horizontally and vertically to 

the camera (right). 

Used this way, you shouldn't need a fill, but if you wish 

you can use another soft source on axis with the camera 

and 1 to 2 stops weaker than your main light. I like 12 x 

16" softboxes for this, and again, a grid is handy. If you 

elevate the light slightly, a 20° grid should drop the 

light beam behind the subject after providing fill, 

without hitting your background. 

The background light should be a controllable, 

directional source with some focusing capability, and it should accept barndoors, gels, etc. Choose an 

area of the location that represents the interests of the subject. Offices usually have bookcases, for 

instance; an orchestra conductor's office may have a music stand with a score open on it, or a wall of 

the conductor's favorite antique batons. A gel will add some mood to the scene and make the 

mundane a bit more exotic. 250-300 watts should be enough for this. You want to bring the objects 

into view, but you don't want them to overwhelm the shot. Some specialty lights like the Dedolight 

feature optical projection attachments (sometimes called "cucaloris" or "cookies") so you can add 

Venetian blind-like or leafy break-up patterns to the background. Rosco makes hundreds of patterns 
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to choose from. You can even project a custom slide. Gridding your main light is especially important 

here to maintain the integrity of your carefully lit background. 

 

An alternate set up (left) uses the 12 x 16"; softbox as a side light instead of a fill. Place the light at 

the subject's head-and-shoulder level and slightly behind, just glancing off the head, cheek and 

shoulder area. Again, a grid is handy in controlling spill into the lens. If you're using a raw light, use 

barndoors for this. You might want to gel this light too: orange sidelight and blue background light 

or vice versa; the warm-cool color friction usually makes for a compelling image. 

Although fluorescent sources are increasingly popular, they're a bit bulky, and so, tungsten is still 

more widely used. This means you have to assess the color balance of your room. Are there windows 

and if so, what's the exposure? North or east will spread a bluer light than south or west, which will 

be warmer. Is the room lit with overhead fluorescents? What kind? Is it lit with high-hat recessed 

fixtures or MR-16 halogens? Can they be turned off? 

White Balance: the great equalizer 

In order to white balance, you're seeking fairly homogenous light conditions around your subject. 

But what if they're not? Balancing out one problem can frequently aggravate another. You could 

overwhelm the ambient light with sheer wattage but that would require a lot of weight and 

equipment. Interviews are all about speed and portability. 
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Making all of your sources the same color 

Let's assume for the moment that you are using tungsten light. Your lights are 3200K, and the room 

lights are either 2500-3200K, if they're tungsten. If they're fluorescent they're 3500K for warm 

white, 4500K for cool white or 6500K for daylight balanced. 

Kelvin represents just the red-blue spectrum of color temperature. Most fluorescents have a degree 

of green to contend with: up to 30 points. Throw your window light into the mix and you have three 

disparate light sources which you can't white-balance away. A large film production crew would gel 

the windows and overheads or sleeve the fluorescents to match your lights, but I'm guessing that's 

not in your budget, either time-wise or financially. 

Plan B is to just turn the overheads off or at least disable the lamps in the immediate area around 

your set. Then you've only got the windows to deal with. Mid- to late-afternoon sun will probably 

come in close to 3200K, but I'd have some sheets of Rosco 3316 (1/8th blue) or 3208 (1/4 blue) on 

hand to put on your lights, just in case. For strong blue north window light, pack some 3204 (1/2 

blue) or 3202 (full blue) which will raise the color temperatures of your lights from 3200K to 4100K 

and 5500K respectively, to match the incoming window light. Then you can read for white balance. 

It's not written in stone. It just has to look good. Of course, you can eliminate this entire step by 

shooting at night, or in a windowless area. 

I haven't listed filtration to match the various temperatures of overhead fluorescents because I'd 

rather exhaust every other possibility first, but you'll probably be adding #3304 (Rosco "Plus green"; 

approx. 30 points of green) for 3200K lamps, #3304 + #3204 for 4100K lamps and #3304 + #3202 

for 5500K lamps–if you go this route. 

It's a bit confusing, but the concept isn't: make all your light sources the same color before white 

balancing. Remember, these gels are added to your light sources to match them to the ambient 

source. 
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Top 8 Goals of Lighting Your Scene 

 

I’m sure you’ve heard this, “If you light it right…” or “With good lighting, the scene will…” What does 

that mean? What is “good” lighting?  

Lighting has nearly infinite permutations and variations. There is certainly no one “right” way to 

light a scene. As a result, there is no chance that we can just make a simple list of “proper” lighting 

techniques. What we can do, however, is try to identify what it is we want lighting to do for us. What 

jobs does it perform for us? What do we expect of “good” lighting? Starting this way, we have a better 

chance of evaluating when lighting is working or us and when it is falling short. Naturally, these are 

generalizations. There are always exceptions, as there are in all aspects of filmmaking — staging, use 

of the lens, exposure, continuity, editorial, and so on. 

What are the Goals of Good Lighting?  

So what is it we want lighting to do for us? There are many jobs, and they include creating an image 

that has: 

• A full range of tones and gradations of tone 

• Color control and balance 

• Shape and dimension in the individual subjects 

• Separation: subjects stand out against the background 

• Depth and dimension in the frame 
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• Texture 

• Mood and tone: emotional content 

• Exposure 

The Lighting Triangle 

  

Now that you have your lights it's handy to know 

how to use them. Turning them on and pointing 

them at your subject is a good start, but if you really 

want to get the most out of them you can use what's 

known as "the lighting triangle." 

 

Unlike its Bermuda cousin, the lighting triangle 

doesn't make stuff disappear... it makes it show up! 

At least, it makes it more visible, more dynamic, and more dramatic on camera.  

Check out the diagram below: 
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 It works like this. First you have the "key 

light," which is the main light for your setup. 

It should be off to one side and slightly angled 

on the face of your subject. This is the light 

that shows most of the details.  

Next is the "back light." As the name implies, 

this one goes behind the subject and casts a 

nice little halo of light in their hair and 

shoulders. This is what's known as a "rim" in 

professional circles... it helps to separate the 

subject from the background and highlights 

their shape and silhouette.  

Finally there's the "fill light." This is a flood 

light that hits the subject from the opposing 

side from the key light. It should be more 

diffused than the key light, allowing the 

shadows to stay on the subjects face but brightening them up enough to let the detail show through.  

 

If you use the lighting triangle I guarantee you that you'll notice your videos looking a little more 

"professional." This is handy for interviews, but it can also be used for what we call "product shots." 

In other words, footage of an item like a birthday gift or a new car or whatever.  

And even though it's not always required, sometimes you may want to throw a fourth light into the 

mix. This one would be the "background light," and it does exactly what the name implies... aim it at 

the background to highlight it more.  

 

Those are some basic lighting tips and if you play with them they'll take you a long way. You can also 

try things like throwing colored "gels" on to your lights (available at a theatrical supply store). Just 

like anything else when working with video the trick is to be creative and inventive. 
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Basic 4-Light Set-up with hair light added: 

 

Basic 4 light setup with added hair light. 2 lights in front are directly lighting the subject, the key and 
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the fill. The key on the left is closer and brighter. The fill on the right "fills" in the shadows on the 

right. The difference in brightness between the two lights produces a "lighting ratio" that gives the 

face shape compared to a single light straight on. If there is no ratio the lighting is considered "flat" 

and looks less 3 dimensional. Two lights light up the background. Fluorescents are especially good at 

providing an even lighting for green screen or blue screen work. The hairlight is a smaller light that 

provides highlights in the subjects’ hair, it is the small round fixture close to the background and 

would be over the subject directed down. 

 

 

 

 

 

 

 

Simple 3 Light Set-up, optional hair light: 

 

This is a simple set-up with 3 lights, still suitable for green screen. 1 light in front lights the subject, 

the light should be placed so light hits both sides of the subjects face, yet slightly off to the side to 



 

 

 

42 
 

 

provide some 3-dimensional modeling of the face. A fill card or reflector can also be used on left side 

to fill in shadows. Two lights on the background provide for even keying. 

 

 

 

 

 

 

 

 

 

 

3 Light Interview Setup: 
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This setup was used for a television commercial production promoting a vocational school. I used 3 

lights of equal power: a main at full power, a hair light in the vertical position with barn doors at full 

power and a background light to illuminate the action behind the main talent. The main light was 

just off camera left. I was looking for minimal modeling on the talents face. It saved time and 

allowed me to use the 3rd light on the background. I find this setup more pleasing on females; males 

look better with a stronger contrast achieved by moving the main light forward and left. The hair 

light provides good separation from the background and the background light shows detail but is 1.5 

f/stops darker than the main subject. This was done to show the action without overpowering the 

main subject 

Add Background Lighting To Achieve Three-Dimensional Space 
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Lighting the background of your shot can add depth to a scene and up the production value of your 

project. Here’s everything you need to know about the technique. 

The primary focus of lighting is to expose your talent in a manner that correctly accentuates the tone 

of the story, as well as maintaining the practical principles of a composition — exposure, shadow 

detail, highlight detail and so forth. A secondary, and often overlooked area, is background lighting. 

 

Background lighting is the act of illuminating the area behind the actors, which is often out of focus 

and perhaps even obstructed by the talent themselves. The first question: Why even bother to light 

the background if it’s going to be out of focus and possibly only partially viewable? The principal 

reason is that background lighting helps creates three-dimensional space within a two-

dimensional plane. 

In real life, everything has a dimension — height, width, depth. We can answer questions relating to 

visual properties from having this information. How tall is that building. How far is that man? The 

core principle of any screen is that it is two-dimensional. Cinema screens, television sets, mobile 

phones, and computer screens are flat surfaces. The visual information from those screens cannot be 

measured, especially, and most importantly, the depth. 

Naturally, an audience member should be able to watch the film or TV and accept that what is being 

shown is an actual representation of the three-dimensional characteristics of those objects. It is a 

filmmaker’s duty to portray this correctly. On the flipside of that, a filmmaker can also use it to his or 

her advantage by manipulating what the audience perceives as an actual three-dimensional 

representation. 

A primary example would be forced perspective, a technique that was used in The Lord of the 
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Rings to make Ian McKellen’s Gandolf seemingly tower over his Hobbit friends. 

The term to describe the on-screen depth is called deep space. Sometimes it’s referred to as deep 

staging. This is the illusion of a three-dimensional space on a two-dimensional surface. This 

is achieved using a number of depth cues: 

• Perspective 

• Size Difference 

• Object Movement 

• Camera Movement 

• Camera Focus 

• Tonal Separation 

• Color Separation 

The key features we will look at are tonal separation and color separation, because this is chiefly 

achieved with lighting. Background lighting serves to add interest, not attention; as soon as the 

background feature becomes more important than your talent, you’ve failed. 

Background lighting can also act as a function to separate your actor from the darkness of a dark set. 

In this shot below, I was attempting to mimic the cinematography found in NBC’s gone-too-soon 

Hannibal. 

The shot on the left had not correctly set the lighting up to fully separate the actress from the dark 

environment. As a result, the actress merges into the darkness of the set.  

Before we continue, it’s important to distinguish the difference between backlighting and 

background lighting. A backlight hits an actor or object from behind and is usually placed higher 

than the object it is lighting. A backlight is often used to separate an object or an actor from a dark 
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background, and to give the subject more shape and depth. Backlighting can help bring your subject 

out and away from looking two dimensional. 

  

That lamp in the shot  helps to break Hannibal away from the background. 

 

Four Techniques for Great Background Lighting 

There are a few ways to go about lighting your scene’s background. Here are four that work every 

time. 

1. Color (Temperature) Separation 

 

If you don’t have a full lighting kit at 

hand, this could be your cheapest and 

easiest method to break your actors away 

from flat space and further your 

production value. If your actor is being 

exposed with tungsten lighting, you can 

use sunlight or converted tungsten light 

to illuminate the background. Of course, 

it can also be the other way around. Take 
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the shot above from Terrence Malick’s The Tree of Life. 

Brad Pitt’s character is being exposed by a household lamp, which the camera has been calibrated 

for, and the background has been lit with natural sunlight. It separates the talent from the 

background and forms natural depth to the scene. Using complementary colors will always add a 

nice aesthetic to the scene. 

2. Practical Lighting 

 

I have to apologize for the following tip. If you haven’t noticed this already, it’s going to ruin a lot of 

films (like A Serious Man, seen above) and TV shows for you. Household lamps are perfect for 

adding pools of light across the background of your set. It can bring your actors away from their 

environment and stop the composition from becoming flat. Here’s the part which you might hate me 

for: Almost all practical lights used in the background serve no actual purpose to the scene or 

characters. In fact, in most circumstances, there’s enough light for there not to be a lamp on. 

However, in practicality, they do a good job of adding texture (and interest) to the background. 
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3. Sunlight Slash 

In the book Set Lighting 

Technician’s Handbook – Film 

Lighting Equipment, Practice, 

and Electrical Distribution, 

author Harry C. Box says: 

Light tends to build up on 

backgrounds and can start to 

flatten everything out. The 

gaffer looks for ways to break 

up the background or create 

variation, gradation, or 

particular highlights. If a scene 

takes place in a set with lots of 

windows, it is natural to scrape 

a slash of sunlight across the far wall, and across the furnishings. Large Fresnels or PARs are 

commonly placed outside of windows for this purpose. 

A single streak of light is one of the most efficient ways to break up the foreground from the 

background. Filmmaking company Stillmotion used this technique in a book trailer for author 

Stephanie Henry. 

Fortunately for us, they also made a blog to accompany the video, and they provide stills of the light 

streak and how it was created. It’s worth reading the entire blog, as  

Patrick Moreau breaks down a lot of lighting tips. As you can imagine, the scene below would fall 

pretty flat without that streak going across the background. 
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A sun streak can be achieved by using a set of flags, and it’s widely recommended to use a Fresnel 

lamp because of their small surface area (that will create a harder light, great for shadows). If you’re 

not in possession of flags, look around at your location and see what on-set obstacles you can find to 

cut the light. I once achieved this effect by placing the Fresnel behind a door that was ajar. 

4. Shadows 

Alternatively, instead of just a solid 

streak of light, you can employ the use 

of shadows to your composition. A 

favorite and classic of cinema in itself 

are the use of blinds or window frames. 

With many Fresnels, you can place a 

gobo to project a pattern onto the wall. 

If you don’t have a gobo, you can use 

actual objects like plants or trees. It’s 

hard because we don’t have the before 

shot, but I can tell you that the still above (from Akeelah and the Bee) wouldn’t be the same without 

the background light and shadow. 

Bonus Consideration: Flat Space  
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It’s worth mentioning that sometimes flat space is exactly what you want to achieve. Flat space 

emphasizes the two-dimensional aspect and can work toward your goal of highlighting a particular 

symbolic meaning. 

Take the still above from Garden State. Zach Braff’s character is very much having an identity crisis 

in the film and doesn’t know where he belongs in the world. The flat cinematography (along with the 

matching shirt) puts him in a position of almost being invisible. This would not have had the same 

symbolic meaning if any of the depth cues — perspective, size difference, object movement, camera 

movement, camera focus, tonal separation or color separation — were present. 

 

Still Portrait Photography Shoot 

PORTRAIT PHOTOGRAPHY 

The main purpose of portrait photography is to capture the essence of a person.  There are 4 

different genres of portraits you are going to experiment with in this unit.   

 1. FORMAL PORTRAITS- POSED, SERIOUS, USUALLY SMILING, UPPER BODY OR FULL BODY 

SHOTS, SUBJECT IS IN A NON-NATURAL LOCATION/POSITION/CIRCUMSTANCE 

 2. CASUAL PORTRAITS – MORE RELAXED, SUBJECT MAY OR MAY NOT BE SMILING, MAY 
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BE A TGHTER CLOSE-UP SHOT, CATCHES THE MOOD OF A SUBJECT, MORE NATURAL 

CHOICE OF LOCATION/POSITION 

 3. PERSONALITY PORTRAITS – FUN SHOTS, VERY CUTE, DEPICTS THE PERSONALITY OF 

THE SUBJECT THROUGH FACIAL EXPRESSIONS OR ACTIONS, CAN INCLUDE “DRESSING 

UP”. THIS TYPE CAN ALSO INCLUDE INCONGRUITY OF ELEMENTS ASPECT TO DEPICT A 

PERSONALITY. 

 4. ENVIRONMENTAL PORTRAITS – THE ENVIRONMENT IS SHOWN, HELPS TO GIVE THE 

WHOLE STORY OF WHO THAT PERSON IS – YOU SHOULD CONSIDER BOTH THEIR 

PRIMARY ROLE IN LIFE, AS WELL AS ANY OTHER PERSONA THEY ADOPT ON A REGULAR 

BASIS. 

PORTRAIT ASSIGNMENT: 

Choose someone who is going to be your subject for this unit. You will take the following sets of 

portraits.  

FORMAL PORTRAITS: Have your subject dress in appropriate attire for a formal photograph – suit, 

dress, slacks and shirt, etc. and choose a location which is appropriate for a formal portrait. If you 

have access to a studio set-up with a background, use it. If not, choose a building or location with 

good background architecture to use. Shoot 5 different poses for a FORMAL portrait session. Shoot 

each one full length AND bust only, for a total of 10 shots. 

CASUAL PORTRAITS: Have your subject dress in appropriate casual wear and choose a location, 

which is more relaxed than you used for the formal portraits. Blue jeans, a cute skirt outfit, a 

sundress, or a short set might be appropriate attire. Locations could be in a yard, a field, a riverbank 

setting, a beach, a front porch, a staircase, etc. The poses should be more relaxed – sitting on the 

ground, lying on the ledge, sitting on the stairs, etc- and the subject should experiment with facial 

expressions – smiling, thoughtful, pensive, etc. Shoot 10 different shots – different poses or 

locations or angles. 

PERSONALITY PORTRAITS: Subject can dress up or use props or you can have the location or the 

action in the shot depict the subject’s personality. Examples: a teenager playing with a toy, a child 

playing hide and seek, an adult making silly faces – etc. Shoot a series of 5 shots for this set. Now, 

discuss your subject’s hobbies and activities. Choose at least two DIFFERENT elements of their 

personality or hobbies or interests which you can use to create an incongruity of elements shot. For 

example: a girl who takes ballet, but loves football. Take a shot of her in a tutu with a football jersey. 

Take a series of 5 shots for this set. 

ENVIRONMENTAL PORTRAITS: Set up and shoot 5 different environmental portraits of your 

subject depicting that client’s primary role in life – student, teacher, parent, etc. These should not 
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require any unusual costume changes or props or locations, since these are to depict the person’s 

primary role.  Discuss with your client what other type of persona they wish to present during an 

environmental shoot. It could be that they are AN ATHLETE, A THEATER PERSON, AN AWARD 

WINNER, OR AN OUTDOORSY PERSON.  Decide what clothes and props are needed for the 

persona shots, and make arrangements to procure them. Set up a shoot in a location that is 

compatible with the chosen persona and take 5 different environmental portraits of your subject 

depicting the chosen persona. 

When you finish, you should have a total of 40 GOOD shots of your subject. You will load all 40 

shots into an album on Google Drive. Have your subject sit with you and critique your efforts. 

Transcript the critique turn it in with the photos. Have the subject choose his/her favorite 10 shots of 

the 40. You will turn in those 10 for grading and peer critiquing. 

 

Enhancing Photos 

This section focuses on both the enhancement and restoration of photographs.  These techniques 

can be used to fix a damaged or old photo through lighting, color and focus.  Students will also 

learn how to edit and manipulate a photo by altering the actual pixels of a photo.  This is 

commonly used in print layouts to retouch photographs in terms of omitting, adding or moving 

parts of a photo.  You can also create a stylized design by applying filters to the pixels. 

 Resizing and controlling light and color without changing physical attributes of the image  

Tools Techniques 

Process and Outcome 

Crop tool Select the Crop tool from the Tools panel (or press C on 

the keyboard) 

 

Adjust the crop box by dragging the handles or sides 

 

Double-click inside the crop box 

 

*Function contains handle (adjustment anchor points), 

shield (tinted crop preview) and rule of third (displays 

intersecting focal points) guides to optimize crop 
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technique 

 

Removal of the outer parts of an image to improve 

framing 

Red Eye Select the Red Eye tool 

 

Click the red portion of the eye in your image 

 

Pupil Size: Use the slider to increase or decrease the size 

of the pupil. 

 

Darken Pupil: Use the slider to darken or lighten the color 

of the pupil. 

 

*Red Eye tool works only with RGB or Lab color images 

 

Eliminates red eyes within a photo caused by large 

amounts of light from a camera flash reflecting off the 

surface of a person’s eye when their pupils did not have 

enough time to constrict  

Adjustment Layers Duplicate photo layer 

 

Click create new fill or adjustment layer button on layers 

panel 

 

Layer – New Adjustment Layer  

 

Alters the light/color of a photo by adjusting elements 

such as brightness/contrast, levels/exposure and 

hue/saturation; Enhances the quality of photos 
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Dodge/Burn Open an image with under- or overexposed areas 

 

Duplicate the layer  

 

Select the Dodge or Burn tool from the Tools panel 

 

(O key chooses the active toning tool; Shift+O to 

cycle through toning tools) 

 

In Option Bar: 

*Select a brush from the Brush Preset Picker or 

toggle open the larger Brush panel. 

*Larger, softer brushes spread the dodging and 

burning effect over a larger area, making blending 

with the surrounding area easier; range options use 

Shadows to lighten or darken detail in the darker 

areas of your image, Mid tones to adjust the tones of 

average darkness, and Highlights to make the 

brightest areas even lighter or (more frequently) 

darker. 

Select the amount of the effect to apply with each 

stroke by using the Exposure slider or text box. 

 

Enable the Airbrush option for a softer, more 

gradual effect. 

 

*Check the Protect Tones option.  

 

Paint over the areas you want to lighten or darken 

with the toning brush, gradually building up the 
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desired effect. 

 

If you go too far, press Command+Z to reverse your 

most recent stroke. 

 

Dodging and burning originated in the darkroom, 

where photographers salvage negatives containing 

areas that are too dark or too light by adding or 

subtracting a bit of exposure 

Layer Mask Option 1 

Click quick select tool – select part of image to keep 

 

Layer – Add layer mask – reveal all/hide all 

 

Click move tool – place bottom image to desired spot 

 

Option 2 

Layer – Add layer mask; brush tool – select brush 

size/hardness/style type – opacity 

 

Set foreground color to black (inverse black to white 

to reverse mask; gradient tool to fade mask) 

 

Can be applied after any other tool to have the 

function only effect part of the photo; black 

reveals/white conceals layer underneath 

Filters 

Blur 

Select the Blur/Sharpen Tool  
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Sharpen Select brush size/hardness/style type  

 

Click and hold mouse on area to be 

blurred/sharpened 

 

*For Smudge Tool, apply same technique except drag 

mouse in the direction you would like the smudge to 

be directed  

 

*Also has tilt-shift blur (gradient blur applied above 

and below an axis line) and smart sharpen (more 

specific sharpen effect options) under Filter on the 

menu bar   

Blur and sharpen tools allow users to emphasize or 

de-emphasize image pixels; smudge tool blends 

pixels simulating as if a finger is dragging through 

wet paint  

 

Resources:  

Suggested Topics: Crop and Transform; Image Adjustments; Filters (view all tutorials within each topic) 

https://helpx.adobe.com/photoshop/how-to/graphic-design-basics.html?set=photoshop--fundamentals  

Suggested Tutorial: Edit your first photo in Photoshop 

https://helpx.adobe.com/photoshop/how-to/photo-editor.html  

 

SUGGESTED EXERCISES: “Old to New” (Restoration and/or enhancement of personal photograph); 

Black and white with color tint emphasis 

 

 

 

https://helpx.adobe.com/photoshop/how-to/graphic-design-basics.html?set=photoshop--fundamentals
https://helpx.adobe.com/photoshop/how-to/photo-editor.html
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Photo Editing Lesson Plan 

Aim: Students will be able to cut and edit objects in a photo to create a radial design on Adobe Photoshop 

creating a color wheel.  They will use adjustments, effects and filters to add depth, space, contrast and balance 

to their work 

Objectives: 

● Understand basic photo editing functions in Adobe Photoshop to create digital media art 

● Identifies when to use the elliptical lasso, rectangular lasso and quick selection tools.  

● Uses free transform and rotate commands to demonstrate overlapping and repetition in radial design 

● Utilizes Fx, opacity, blend modes, layer adjustment and filter gallery functions to develop an 

aesthetically strong composition  

 

Materials: 

Example art prints  
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Print out of step-by-step instructions  

Students will be able to: 

• Order hues on the color wheel 
• Design a color wheel using images 
• Manipulate layers 
• Use layer masks 
• Use the line tool 
• Use adjustment layers 
• Find and appropriately use copyright free images 
Prior knowledge: Students should have some familiarity with primary and secondary colors. 

Students should know how to open and save files in Photoshop. Students should know how to use 

the Transform function to rotate and resize images. Students should know how to use rulers and 

guides. 

Time: approximately 2-4 classes  

Teach: 

Part One – Preparing file 
• Open a 7” x 7” image at print resolution 
• Have students add horizontal and vertical guidelines centered on the image 
• Demonstrate how to use the line tool 
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• Have students use the line tool to divide canvas into 12 wedges (go from the 
center to the edge in 30 degree increments) 
 
Part Two – Finding an image 
• Discuss copyright with students 
• Introduce students to where to find copyright free images  
• Remind students they can always use their own photographs 
• Have students find an image with two bright, contrasting colors that are a 
shape that will fit in a wedge when sized appropriately 
 
Part Three – Duplicating the image 
• Have students copy and paste image into their color wheel. 
• Have students transform and resize image until it fits a wedge 
• Have students use a layer mask to hide all but one wedge 
• Have students duplicate layer, transform, and rotate 30 degrees to fit another 
wedge 
• Repeat the last step. Students should now have three wedges, all touching. 
• Select all three layers with wedges, duplicate all, transform and rotate 90 
degrees and move so that now half of the wedges are filled 
• Select all six layers, duplicate all, transform, and rotate 180 degrees and place 
so that all wedges are filled 
 
Part Four – Adjusting the colors 
• Students will now add adjustment layers to each wedge. Have them make 
sure the image is selected (not the layer mask) when adding the 
Hue/Saturation adjustment layer 
• Students will adjust each layer so that the item matches the following colors, 
going clockwise from top: yellow, yellow-orange, orange, red-orange, red, 
red-violet, violet, blue-violet, blue, blue-green, green, and yellow-green 
• When finished, students will save the file as both a .psd and a .jpg 
• Students will then adjust the image so that the background behind their item 
matches the color wheel hues, and save under a new name as a .psd and a .jpg 
 
Part Five – Critique and Discussion 
• (For art students) How do the colors on the computer behave differently 
from paint? Is there a color that is more dominant in your color wheels than 
when one is painted? (CYMK vs. RGB) 
• How do the colors of the background change in the color wheel where you 
varied the hue of the images? How does this color wheel compare to the one 
where you varied the hue of the background? Why do you think this is? 
• What difficulties did you have? What was harder than expected? What was 
easier? 
• Do you know of any steps in this process that could have been done a 
different way? Would it be quicker or slower to do it that way? 
• Who do you think did an exceptionally good job on this assignment? Why? 
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Summary: 
Assess student work on the following criteria…   
 

 

Performance 
Indicator 

 

1 

Falls Below 

 

2 

Approaches 

 

3 

Meets 

 

4 

Exceeds 

 
Objects 

● Manipulation 
of  images 

 

 
Used less than 3 varied 
shapes, poorly cut out 
using a selection tool; 
incorrectly masked 
from original photo 

 
Shapes are limited in 
variation, 
imperfections in edge 
quality in both cutting 
masking from original 
photo  

 
Shapes are varied, cut 
out using correct 
selection tool and 
correctly masked from 
original photo with little 
imperfections in edge 
quality 

 
Shapes are varied, 
properly cut out using 
correct selection tool 
and correctly masked 
from original photo  
 

 
Technique 
● Use of Free 

Transform & 
Opacity 

● Use of Adjustments, 
Filters & Effects 

 

 
Rarely demonstrates 
good use of opacity and 
effects to show depth 
and space and 
aesthetically pleasing 
design 

 
Sometimes 
demonstrates use of 
opacity and effects to 
show depth and space 
and aesthetically 
pleasing design 

 
Often demonstrates 
good use of opacity and 
effects to show depth 
and space and 
aesthetically pleasing 
design 

 
Demonstrates strong 
use of opacity and 
effects to show depth 
and space and 
aesthetically pleasing 
design 

 
Composition 

● Visual Balance 
● Radial 

Symmetry 

 
Shapes are not 
circulating from a 
center point and are 
improperly rotated and 
scaled 

 
Few shapes are 
correctly circulating 
from a center point 
and properly rotated 
and scaled 

 
Most shapes are 
correctly circulating 
from a center point and 
properly rotated and 
scaled 

 
All shapes are correctly 
circulating from a center 
point and properly 
rotated and scaled  
 

 

 

Objective  2 - Retouching/Repairing Photos 

Manipulating images by adding, removing or altering parts of a photo 

Tools Techniques 

Process and Outcome 

Clone Stamp Open an image  

 

Select the Clone Stamp tool (S key on the keyboard) 

 

Select brush size/hardness/style type, blend mode and 

opacity in option bar  
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*Adjust options such as Flow Rate percentage (how fast 

clone is applied), Airbrush (blends pixels more evenly) 

 

*Aligned selected, moves clone source cursor to a different 

location. Align deselect, clones multiple times from the 

same location 

 

Select Sample- All Layers to clone part with multiple 

layers; click the Adjustment Layer icon on the Options bar 

to ignore any adjustment layers when cloning.  

 

Click or drag along the area where you want the clone to 

appear 

 

Hold Option-click the area of your image that you want to 

clone 

 

Choose Window – Clone Source to open the Clone Source 

panel. You can also click the Clone Source panel icon in 

the Options bar (just left of the Blend Mode options) 

 

Cleans up flaws in an image by copying information 

from one area to another; application works best with a 

soft brush and low opacity   

 

Layer Mask (Review) 

 

Option 1 

Click quick select tool – select part of image to keep 

 

Layer – Add layer mask – reveal all/hide all 
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Click move tool – place bottom image to desired spot 

 

Option 2 

Layer – Add layer mask 

 

Brush tool – select brush size/hardness/style type – 

opacity 

 

Set foreground color to black (inverse black to white to 

reverse mask; gradient tool to fade mask) 

 

Can be applied after any other tool to have the function 

only effect part of the photo; black reveals/white 

conceals layer underneath 

Patch tool Select the Patch tool 

 

Choose patch mode from Normal (adjusts color and tone 

of the cloned patch to match the destination without 

moving pixels around within the patch) or Content-Aware 

(adapts the cloned patch by moving pixels around to fit 

the destination) 

 

Normal – select Source (flawed area) or Destination (good 

area to clone) on the Options bar. 

 

Select the Transparent option to patch from your source 

pixels with less opaqueness. 

 

You can use the Clone Source panel with the Patch tool. 

 

Content-Aware – choose your desired Adaptation setting 
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(flexibility of shifted pixels) 

 

Drag around the flawed area of your image. 

 

*Drag completely around the flawed area like you would 

when selecting with the Lasso tool.  Apply a slight feather 

to soften the edge of the selection. 

 

Drag your selection to the area on your image that you 

want to clone (or sample) from. 

 

Release the mouse button to patches flawed selection with 

the cloned pixels 

 

Recognizes a whole section of unflawed pixels to correct a 

larger defected area; eliminates differences in color and 

texture   

Spot Healing Brush Select Spot Healing Brush tool 

 

Select brush size/hardness/style type and blend mode in 

option bar  

 

Select a type from the Options bar. 

 

Proximity Match: Samples the pixels around the edge of 

the selection to use to fix the flawed area. 

 

Create Texture: Uses all the pixels in the selection to 

create a texture to fix the flaw 
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Content-Aware: Compares and uses actual content from 

the image close to the flaw.  

 

*Use Content-Aware when removing large items like noise 

or scratches on your image 

 

Choose Sample All Layers to heal an image by using all 

visible layers 

 

Click, or click and drag, the area you want to fix 

 

Copies pixels from one area of an image to another to 

correct defects; recognizes texture and lighting making 

modification more convincing 

 

Filters Duplicate layer – Filter – Filter Gallery (choose style in 

preview window)/Choose filter option to apply to layer 

directly  

 

*filters that can be applied include but are not limited to 

artistic brush, texture, liquefy, render 

 

Contains commands to manipulate or stylize images 

*filter gallery allows users to preview all filters before 

applying 

 

Resources:  

Suggested Topics: Retouching (view all tutorials within topic) 

https://helpx.adobe.com/photoshop/how-to/graphic-design-basics.html?set=photoshop--fundamentals  

Suggested Tutorials: Get started – Essential for beginners – Fix flaws and repair photos 

https://helpx.adobe.com/photoshop/how-to/graphic-design-basics.html?set=photoshop--fundamentals
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https://helpx.adobe.com/photoshop/how-to/fix-flaws-retouch-photos.html?set=photoshop--get-started--

essential-beginners  

 

SUGGESTED PROJECTS/ASSESSMENTS: “Spot the Difference”; Social media magazine cover 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://helpx.adobe.com/photoshop/how-to/fix-flaws-retouch-photos.html?set=photoshop--get-started--essential-beginners
https://helpx.adobe.com/photoshop/how-to/fix-flaws-retouch-photos.html?set=photoshop--get-started--essential-beginners
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UNIT IV – INTRO TO LAYERS 

(appx. 10-15 days) 

    A layer is one image stacked on top of another and allows users to edit photos without damaging 

the original image.  This unit goes through all the functions Photoshop offers to create, edit and 

organize layers in order to enhance or combine images and to design a strong digital composition 

for print or web. 

Objective 1 - What is a Title Screen? 

Title Screen:  A design layout used with the intention of being informative to communicate a 

concentrated level of information within the shortest possible time period. 

Sample Title Screens: 

    

Note taking worksheet below: 

 

BMB Spec sheet for Title Screens: 

Size in pixels hxw specific to BMB Title Screens:  

Set Typeface specific to BMB:  

Set Color Pantone #’s for specific to BMB  

 

 

https://en.wikipedia.org/wiki/Television_news_screen_layout#cite_note-rodrigues-1
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Objective 2- Creating Layers 

Tools Techniques 

Process and Outcome 

Layers 

 

Click create new layer button of layers panel 

 

Layer – New – Layer  

Layer – Duplicate Layer  

 

Provides editing options for specific parts of a photo; 

enables user to keep original image intact  

 

*Make sure to manage layers by arranging, renaming 

and grouping layers to avoid clutter 

Trash  Drag a layer to the trash can icon on the layers panel  

 

Layer – Delete – Layer  

 

Deletes layers  
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Objective 3 - Editing Layers 

Combining multiple photos and revealing/Concealing parts of an image 

Tools Techniques 

Process and Outcome 

Select 

Move (Shift-V) 

 

 

 

 

Marquee (Shift-M) 

 

 

 

 

Lasso (Shift-L) 

 

 

 

 

 

 

Quick Selection (Shift-W) 

 

Click the move tool, click and drag your selection; this will 

cut the selection out from the current location, and 

reposition it to wherever the mouse button is released. 

 

The move tool is used for moving selected areas of an 

image, layers, shapes, and other objects. 

 

Click marquee tool, hold down your mouse button over 

the active image area, and drag out your shape. 

 

The marquee tools are used to make rectangular, 

elliptical, horizontal and vertical line selections. 

 

Click the lasso tool, drag a freehand selection with your 

mouse 

  

The Lasso Selection Tools allow you to make selections of 

irregular shapes.   

 

*The magnetic lasso tool tries to automatically create 

points itself while you follow the edge of your object 

 

Click the quick select tool, click and hold to select desired 

amount.  Increase or decrease selection in the option bar 
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The quick select tool recognizes similar pixels and quickly 

selects area to be edited. 

 

*The magic wand tool, allows you to click the color 

you want to select in the active image area.  Best used for 

solid colored objects 

 

Identifies what part of a layer or photo will be edited.  

User should decide what selection tool based on the type 

of editing that will be done 

 

* Cmd/Ctrl+Shift + J to Move a selection to a new layer 

Layer Mask Option 1 

Click quick select tool – select part of image to keep 

 

Layer – Add layer mask – reveal all/hide all 

 

Click move tool – place bottom image to desired spot 

 

Option 2 

Layer – Add layer mask 

 

Brush tool – select brush size/hardness/style type – 

opacity 

 

Set foreground color to black (invert black to white to 

reverse mask; gradient tool to fade mask) 

 

Hides or reveals parts of different layers for purposes 
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such as separating an object from its background or 

combining parts of two different photos; Allows you to 

paint away parts of your layer without damaging your 

original image. 

* Hold Option/Alt while adding a mask to create an 

inverted layer mask 

Adjustment Layer Click create new fill or adjustment layer button on layers 

panel 

Layer – New Adjustment Layer  

 

Alters the light/color of a photo by adjusting elements 

such as brightness/contrast, levels/exposure and 

hue/saturation; Enhances the quality of photos 

Blend Modes Click drop down menu on layers panel 

 

Determines the way pixels in two layers react with each 

other when painting or editing them  

Opacity Change opacity percentage on layers panel 

 

Change opacity on option bar when specific tool is 

selected 

 

Identifies the amount of transparency a layer or object 

has compared to another layer 

FX Click FX button on the layers panel 

 

Layer – Layer Styles – Blending Options 

 

Applies layer effects such as drop shadows, strokes, 

overlays, gradients, bevel emboss and glows to images or 

text  
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Objective 3- Organizing Layers  

Tools Techniques 

Process and Outcome 

Stacking Order Slide layers above or below one another 

 

Layer – Arrange  

 

Layers that are placed on top of another are more in 

front on the canvas; layer that are meant to overlap 

another should be placed above in the layers panel 

 

The background should remained locked as the bottom 

layer if the user does not want to original image to be 

compromised   

Eye Icon Click eye icon next to each layer  

 

Layer – Hide Layer 

 

Allows users to view certain layers at a time or hide 

layers that do not need to be edited without having to 

delete them  

Group Click create new group button on layers panel 

 

Layer – New – Group  

 

Combines multiple layers to be moved or edited 

simultaneously; keeps smaller or similar edits organized 

together 
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Merge Turn on the visibility of only the layers you want merged 

then choose merge visible from the Layers Panel  

 

Merging layers is helpful when you no longer need every 

layer to be independent. It combines layers to create a 

composite and want to consolidate it to one layer 

 

Resources: 

Suggested Tutorials:  Learn Essentials – Design Techniques – Create your first design in Photoshop – Get to 

know layers, Combine images using layers 

https://helpx.adobe.com/photoshop/how-to/graphic-design-basics.html?set=photoshop--fundamentals  

 

 

SUGGESTED EXERCISES PROJECT: Using your own original images to create their own Title 

Screen for Mepham’s Broadcasting Audio Reports Segments 

Using a combination of photographed imagery and original titles create a Title screen in Adobe Photoshop for 

specific Mepham broadcast segments such as... 

● Broadcasting Journalism Anchors 

● This moment in Sports teams: captains, players or generic sports paraphernalia  

● This moment in Arts:  Paintbrushes, cameras, film, Art work etc. 

● Mepham moments, etc.  

● In the classroom…  Smart Boards, pencils, books, etc. 

 

 

 

 

 

 

https://helpx.adobe.com/photoshop/how-to/graphic-design-basics.html?set=photoshop--fundamentals
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Title Screen for Audio Report Masking & Stacking Layers LESSON 1 

Aim:  Students will be able to cut objects out of  images and combine them into one cohesive composition 

Objectives: 

● Create an original title screen by removing image backgrounds from each element (see suggestions 

from list above)  using selection, lasso, eraser and marquee tools 

● Use transformation tools to combine and organize the layers 

● Demonstrate a more realistic look by adding effects, adjustments and opacity  

Materials: Original images for creating their own title screen for BMB segments. 

For example: 

● Paintbrush.jpg 

● Palette.jpg 

● NAHSbanner.jpg 

● Sample Image of Banner 

Step-by-step instructions for Stacking & Masking Layers 

1. Save all images into a TITLE SCREEN folder 

2. Open all .jpeg images in Photoshop 

3. Check the DPI of each 
● Go to:  Image→  Image size→ Be sure DPI/Resolution is 300+ 

● File → Save as→  easily recognizable name. jpg 

● Do this for all files.  → Possible class extension: how to Batch files 

 

4. Go to:  File →  New 

●  Select  Film & Video presents →  Choose:  DPI specific to BMB Specifications 

5. Go to:  File → Scripts → Load Files into Stacks →  Click Browse  

This will place all images within that folder into layers of a document within Photoshop 

 

6. Direct students to the layer bar and introduce them to the Visibility Icon (eyeball) 

●  Use the eyeball/ Visibility icon to hide all but the top layer 
 

7. Direct students to the Layer Mask Icon on the bottom of the layer bar and CLICK the layer mask icon 

to add a mask on that layer.  Activate the Layer mask! 

●  How do you activate the layer mask? 

a. Click on the Mask (will initially appear to be a white box)  

b. White border will appear to indicate either the Layer Mask or the Imagery are 

activated/selected 
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8. Choose Brush Tool – and show changes 

● Review  how to changes the brushes edge hard vs. soft  

● Review how to change the brush size size changes  

(Bracket tools left/right to make brush large/smaller using key commands) 

While on the layer mask… 

● Use the color picker to choose black to paint away/remove imagery (background info.) 

● Use the color picker to choose white paint information back into the layer mask (subject) 

 

This process can be combined with magic wand or quick selection tools. 

Repeat this step to remove background for each layer  

 

9.  Check edging by  zooming  into the layer mask  

●  How do you zoom into the layer mask? 

a. Click ALT to zoom into the layer mask click on the image layer to get out of zoom. 

b. Repeat this step to remove background for each layer  

 

10.  Apply layer mask to make the mask permanent 

● How do you apply a layer mask? 

a.  Right click on the layer mask icon to: 

● Apply the layer Mask (making it permanent) 

● Disable the Layer mask (temporarily hide masking) 

● Delete the  Layer mask (remove the mask all together) 

11.  To save all work go to: 
● File→  Save as:  Title Screen_lastname.psd 

● Be sure to choose the .PSD extension in the drop down menu 

○ .PSD files will retain all your working layers ←  :)   

○ .JPG files will flatten your layers making the imagery uneditable ← X 
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Title Screen for Audio Report Project Resizing and Rearranging LESSON 

2 

Step-by-step instructions for Arranging and Resizing layers 

1. Open Photoshop →  File → Open → TitleScreen_Lastname.psd 
2. Select your MOVE tool in the top of your toolbar. 
3. Be sure to check the AUTO SELECT box to activate/select the individual layer that you click on. 
4. Rearrange your layers in the composition that you like the best 

●  Where are my layers? 
○  Go to → Window → Layers to pull open your window panel  

(this is also where most of the Photoshop panels are located.) 
●  How do you know what layer you are on? 

○  The current layer selected will be highlighted on your layer bar… for complex layers you 
may turn off (uncheck) AUTO SELECT  to select the layer you wish to adjust manually 
via the layer bar. 

 
 

5.  Rearrange your layers in the proper order on the layers panel from top to bottom 
a. Look for the layer you wish to select in your layer panel 
b. Click to select the layer you wish to rearrange (it should appear highlighted) 
c. Drag that layer to the top of bottom of the layer panel to switch the order (top to bottom) and 

overlap where appropriate 
6.  Resizing individual layers 

a.  Look for the layer you wish resize in your layer panel 
b. Click to select the layer you wish to resize (it should appear highlighted) 
c. Go to:  Edit → Transform → Scale 

Key command Shortcut: COMMAND T to activate transform  
 
d.  Hover over the corner of that image to see the arrow icon…  
that means you are currently able to transform. 

 
IMPORTANT:  HOLD SHIFT while transforming to keep the image in proportion 

e.  Double click or press ENTER to complete the transformation 
TIP:  You may select multiple layer at once by selecting multiples layers at once  

(Hold CNTRL to select multiple layers at once) then TRANSFORM  
 
7.  File → Save (or Command + S) to save over old edits as a .PSD 
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Title Screen for Audio Report Project Typography LESSON 3 

 

Typography      The style and appearance of printed matter, the art or procedure of arranging                            
      type or processing data and printing from it. 

 

Kerning The spacing between letters or characters in a piece of text to be printed. 

Baseline In typography, the baseline is the imaginary line upon which a line of text rests. 
In most typefaces, the descenders on characters such as g or p extend down 
below the baseline while curved letters such as c or to extend ever-so-slightly 
below the baseline. 

Leading  

The definition of leading is: the distance between two baselines of lines of type. 
The word 'leading' originates from the strips of lead hand-typesetters used to 
use to space out lines of text evenly. The word leading has stuck, but essentially 

it's a typographer's term for line spacing  

Tracking In typography, letter-spacing, also referred to as tracking by typographers 
working with pre-WYSIWYG digital systems, refers to an optically consistent 
degree of increase (or sometimes decrease) of space between letters to affect 
visual density in a line or block of text. 

 

Serif 
 
 
 
 
Sans Serif 

In typography, a serif is the little extra stroke found at the end of main vertical 
and horizontal strokes of some letterforms. Serifs fall into various groups and 
can be generally described as hairline (hair), square (slab), or wedge and are 
either bracketed or unbracketed. 
 

A category of typefaces that do not use serifs, small lines at the ends of 



 

 

 

77 
 

 

characters. Popular sans serif fonts include Helvetica, Avant Garde, Arial, and 
Geneva. Serif fonts include Times Roman, Courier, New Century Schoolbook, 
and Palatino. 
 
 

 

Step-by-step instructions for downloading, installing and manipulating Typography 

Important:  Be sure to reference your spec sheet for all official BMB graphic work.  Should you need to use a 

new typeface for a specific project you may download and install new typefaces but for continuity it is 

important that all official BMB graphic work utilize the same visual standards.  That said, should there be a 

need for a new typeface be Types can be created, purchased or open sourced.  ie.  www.1001freefonts.com  

Downloading and Installing typefaces 

1. Go to your favorite font site and browse the categories of fonts appropriate to your subject. 

2. Type your Title Screen into the PREVIEW BOX and press UPDATE to see your TITLE in the font of 

your choice before selecting. 

3. Click DOWNLOAD to download the .txt files you wish to use. 

4. Go to the FINDER on your desktop and click DOWNLOADS to locate your new type files txt 

● Many of these files will need to be unzipped…  

● Right click on the file folder and select EXTRACT to unzip your type file 

5.  Go to the Launchpad (Rocketship) on your desktop and type FONTBOOK in on the top search bar 

6.  Open the FONTBOOK application 

7.  Drag and drop your extracted (unzipped) type falls to ALL FONTS at the top of the FONTBOOK panel to 

install your new type files.  Some font files require you to click install in a separate window after dragging. 

8.  Files will now appear in your Adobe Programs! 

How to Manipulate your fonts in Photoshop 

1. Open Photoshop →  File → Open → TitleScreen_Lastname.psd 
2. Select one of your  Type  tools “ T ” in the top of your toolbar. 

 Hold down the type tool to select one of the two options 
 The Horizontal Type Tool 

 or 
 The Vertical Type Tool 

3.  Begin typing your Title Screen to create a  TYPE “T” layer in your Layer Panel.   
● Double click on the “T” in your layer panel at any point to reactivate your TYPE options/settings 
● The Type settings will also appear on the top of the Photoshop Panel to adjust the typeface, size, color, 

etc. 
4.  Try the TYPE WARP tool (this looks like a T over a rainbow) on the top of the Photoshop Panel to distort 

http://www.1001freefonts.com/
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the shape of the words to be Arced, Arched, Waved, Inflated etc. 
5.  To adjust the kerning…   

Go to:  WINDOW →  CHARACTER to make adjustments to the font kerning, badline, leads, etc.   
to increase legibility 
 
 

 
Summary:  
Assess student Title Screen designs for their audio reports based on the following criteria…   
 
 
 

 
Performance 
Indicator 

 

1 

Falls Below 

 

2 

Approaches 

 

3 

Meets 

 

4 

Exceeds 

 
Completion  

 
Title Screen design is 
incomplete  

 
Title Screen design  is 
incomplete with some 
missing layers 
components 

 
Title Screen  design 
completed with most 
layers components 
accurately executed 

 
Title Screen  design 
completed with all layer 
components accurately 
executed 

 
Craftsmanship/ 
BMB Specifications 
 

 
No BMB specifications 
were followed. 

 
Few BMB 
specifications were 
followed,  making 
design appear 
unrelated to the 
brand. 

 
Most  BMB 
specifications are 
followed properly used 
making design appear 
somewhat on brand. 

 
All  BMB specifications 
are followed properly 
used making design 
appear professional and 
on brand. 

 
Composition 
 

 
The Design has  no 
visual clarity, or 
alignment, the design 
is difficult to read or 
illegible. 

 
The design has a  
little visual clarity, 
alignment needs 
adjusting to create 
better  visual clarity. 

 
The design has some 
visual clarity, the design 
is legible and elements 
are somewhat aligned. 

 
The design is legible, 
has a great deal of visual 
clarity all elements feel 
aligned and the overall 
design feels intentional. 

 

Photoshop extension: 
Photoshop CC offers many 3D capabilities, including 3D extrusions from layers, type and paths, 
control over the spatial relationships among objects, improved rendering, and generally improved 
performance. It allows you position and animate 3D models, edit textures and lighting, and choose 
from several render modes. 

 
 

Objective 1 - Create a 3-D Object  
 

Extrusio

n 

 Select a path, shape layer, type layer, image layer, or specific pixel areas. 

 Choose 3D > New 3D Extrusion From Selected Path, Layer, or Current Selection. 

Note: To quickly extrude type while editing with the Type tool, 
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click the 3D button in the options bar. 

 With the mesh selected in the 3D panel, select the Deform or Cap icons at the top of the 

     Properties panel. 

 Edit numerical settings in the Properties panel, or drag the interactive extrusion controls 

in the document window. 

 

Meshes Provide the underlying structure of a 3D model. A mesh is often visualized as a wireframe, a 

skeletal structure built from thousands of individual polygons. A 3D model always has at 

least one mesh, and may combine multiple meshes. In Photoshop you can view meshes in a 

variety of render modes, and manipulate meshes independently of each other. While you 

can’t alter the actual polygons in a mesh, you can change its orientation and transform it by 

scaling along different axes. You can also create your own 3D meshes, using pre-supplied 

shapes or by converting existing 2D layers.  

Material

s 

A mesh can have one or more materials associated with it, which 

control the appearance of all or part of the mesh. The material in turn 

relies on subcomponents called texture maps, whose cumulative 

effect creates the appearance of a material. The texture map itself is a 

2D image file that creates various qualities such as color, pattern, 

shininess, or bumpiness. A Photoshop material can use up to nine 

different texture map types to define its overall appearance. 

  

 

Suggested Activities / Exercises: 

● Create a 3-D object from a 2-D beetle image.  
● Create a 3-D photo cube 

 

Resources: 
● Inflation: https://www.youtube.com/watch?v=kqAi5mNa2gM 
● Text: http://planetphotoshop.com/inflated-text-using-3d-in-photoshop-cc.html 
● Photo cube: http://photoshopcafe.com/photocube-tutorial.htm 

 
 

 
 
 
 
 
 
 

https://www.youtube.com/watch?v=kqAi5mNa2gM
http://planetphotoshop.com/inflated-text-using-3d-in-photoshop-cc.html
http://photoshopcafe.com/photocube-tutorial.htm


 

 

 

80 
 

 

Objective 2 - Manipulate a 3-D Object  

Create 3 dimensional logos and graphics for BMB segments using Photoshop 

 

Vanishing Point 

Filter 

Quickly create perspective planes with the Vanishing Point filter, and snap 

an imported object to them. 

• Select an image layer, and choose Filter > Vanishing Point. 
• Using the Create Plane and Edit Plane tools, create a grid to define a ground plane. Then  

     click OK. 

• Choose 3D > New 3D Layer from File. 
The imported object is placed on the ground plane you defined. 

3-D Axis Widget You can manipulate individual 3-D objects within a 3-D layer to compose realistic scenes. The 3D 

Axis shows the current X, Y, and Z-axis orientation of models, cameras, lights, and meshes in 3D 

space. It appears when you select any 3D tool, providing an alternative way to manipulate the 

selected item. 

Minimize, restore, move, or resize the 3D Axis 

Move the pointer over the 3D Axis to display the control bar.           

• Do one of the following:     
 To move the 3D Axis, drag the control bar. 
 To minimize, click the minimize icon. 
 To restore to normal size, click the minimized 3D Axis. 
 To resize, drag the zoom icon. 
Move, rotate, or scale selected items with the 3D Axis 

To use the 3D Axis, move the mouse pointer over an axis control to highlight it, and then drag as 

follows: 

• To move the selected item along the X, Y, or Z-axis, highlight the conical tip of any axis. Drag 
 in either direction along the axis. 

• To rotate the item, click the curved rotation segment just inside an axis tip. A yellow circle 
appears showing the rotation plane. Drag in a clockwise or counterclockwise circle around the 
3D Axis center. To rotate more gradually, move the mouse farther away from the center of the 
3D Axis. 

• To resize the item, drag the center cube in the 3D Axis up or down. 
• To compress or elongate the item along an axis, drag one of the colored transform cubes either 

toward or away from the center cube. 
• To constrain movement to an object plane, move the mouse pointer into the area where two 

axes intersect, near the center cube. A yellow plane icon appears between two axes. Drag in any 
direction. You can also move the pointer over the lower part of the center cube to activate the 
plane icon. 
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Lighting 

 

Types include Infinite, Spot, Point lights, as well as Image-based lights that 

wrap around a scene. You can move and adjust color and intensity of 

existing lights, and add new lights to your 3D scene. 

 

Camera View Use the 3D camera tools to move the camera view while leaving the position of the 3D object 

fixed. 

● In the Tools panel, click a 3D camera tool, and hold down the mouse button to select from the 
following types:  Hold down Shift as you drag to constrain the Rotate, Pan, or Walk tools to 
a single direction of movement.       
 Rotate  -  Drag to orbit the camera in the x or y direction. Hold down Alt (Windows) or 

Option (Mac OS) as you drag to roll the camera.    
 Roll - Drag to roll the camera.  
 Pan  - Drag to pan the camera in the x or y direction. Hold down Alt (Windows) or 

Option (Mac OS) as you drag to pan in the x or z direction.           
 Walk  - Drag to walk the camera (z translation and y rotation). Hold down Alt 

(Windows) or Option (Mac OS) as you drag to walk in the z/x direction (z translation and 
x rotation). 

 Zoom  - Drag to change the field of view of the 3D camera. Maximum field of view is 
180. 

 Perspective Camera (Zoom only)  - Displays parallel lines converging to vanishing 
points. 

 Orthographic Camera (Zoom only)  - Maintains parallel lines without convergence. 
Displays the model in accurate scale view without any perspective distortion.          

 DOF (Zoom only) - Sets depth of field. Distance determines how far the in-focus field is 
from the camera. Blur obscures the remainder of the image         

In the options bar, numeric values show the x, y, and z position of the 3D camera. You can also 

edit these values manually to adjust the camera view. 

● Change or create 3D camera views 

● Select a preset camera view of the model from the View menu. 

● To add a custom view, place the 3D camera in the desired position using the 3D camera 

tools, then click Save in the options bar. 

● To return to the default camera view, select a 3D camera tool, and click the Return To 

Initial Camera Position. 

 

 

Suggested Activities / Exercises: 

● Experiment moving various 3-D objects free hand and using coordinates 
● Place 3-D object in a photograph and adjust light and texture to seamlessly integrate into 

scene. 
● Explore lighting effects with the various options, create a convincing light source for objects on             

several different layers.  
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Resources: 

● Moving 3-D Objects: http://blogs.adobe.com/richardcurtis/2015/05/15/creativefriday-
moving- 3d-objects-cameras-and-rendering-in-photoshop-cc/ 

● 3D Lighting: https://helpx.adobe.com/photoshop/how-to/oveview-standard-3d-lights.html 
● Moving Text: https://www.youtube.com/watch?v=Np_WfV-Q9mA 
● Spinning object with revolving text: https://www.youtube.com/watch?v=fWk9KEILN7M 

 

PROJECTS/ASSESSMENTS 

1. 3-D Text 

2. Text revolving around spinning planet, logo, etc. 

3. 3-D object placed in an environment 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://blogs.adobe.com/richardcurtis/2015/05/15/creativefriday-moving-%203d-objects-cameras-and-rendering-in-photoshop-cc/
http://blogs.adobe.com/richardcurtis/2015/05/15/creativefriday-moving-%203d-objects-cameras-and-rendering-in-photoshop-cc/
https://www.youtube.com/watch?v=Np_WfV-Q9mA
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Creating 3-D Objects Lesson Plan – Text 

 
Objective: 
To create a 3-D object from a two-dimensional text image. 
 

Materials: 
Photoshop CC program 
 

Procedure: 
1. Type a the segments name using a font that has rounded edges and corners. This will help add to the 

rounded shapes of the finished 3-D text.  
2. Convert the text into a 3-D object. With the text layer or the shape layer active in the Layers panel, go 

to 3D>New 3-D Extrusion from Selected Layer. This will immediately extrude the text and make the 
wire mesh ground plane visible.  

3. In the 3-D panel, locate the 3-D text item in the list and click on it. Then, open the Properties panel 
and adjust the Extrusion Depth to 0.  

4. At the top of the Properties panel, click on the Cap icon, (the third icon from the left). This is where 
you can modify the bevel and inflation settings. First, click on the drop-down menu at the top and set 
the Sides to Front and Back. Then, go down to the Inflate section and set the Angle to 90° and increase 
the Strength to about 20%.  

5. Before splitting up the letters, set up the surface properties for the text elements. In the 3-D panel, 
highlight the Front Inflation Material for the text. In the Properties panel, click on the ball icon near 
the top right to open the Material Picker, and select the No Texture material. Click on the color swatch 
next to Diffuse, select white in the Color Picker, and click OK. Set the Shine to 100%, the Reflection to 
75%, and the Roughness to around 25%. Apply these same settings to the Back Inflation Material. 

6. Go to 3D>Split Extrusion. This will allow you to manipulate each letter individually while keeping all 
the letters in the same 3-D layer. Switch to the Move tool (V), and click on the first letter to put a 3D 
box around just that letter. You can now use the 3-D tools and widgets to change the position and scale 
this letter in relation to the other letters. 

7. Starting with that first selected letter, click on its Front Inflation Material in the 3-D panel. At the top 
of the Properties panel, click on the color swatch next to Diffuse and choose a color in the Color Picker. 
Click OK when done. Do the same thing for each of the remaining letters, giving each one a different 
color. You'll notice that the reflection properties all stay the same even when the color changes. 

8. In the 3-D panel, click on Environment at the very top of the list. At the top of the Properties panel, 
just under Global Ambient, will be the IBL (Image Based Light). Click on the icon to the right of the 
preview thumbnail and choose New Texture. In the New dialog, look for the name of the 3-D file in the 
Preset drop-down menu to use the same dimensions as the main file for this new file, make sure 
Background Contents is set to White, and click OK. 

9. Once the new file is created, go back to the IBL menu and choose Edit Texture. Once the file opens, 
press Command-I to invert the white background to black. Then, click the Create a New Layer icon at 
the bottom of the Layers panel, and use the Elliptical Marquee tool (nested under the Rectangular 
Marquee tool [M] in the Toolbox) to create a large oval selection inside the canvas. Press Shift-Delete, 
choose 50% gray from the Use drop-down menu in the Fill dialog, and click OK. Close and save the 
Image Based Light file. 

10. This will change the appearance of the light and reflected elements on the text. With the Environment 
property still selected in the 3-D panel, you can use the 3-D tools to move and rotate the IBL to change 
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the way it appears on the text. You're essentially moving the reflection around the surface of the 
object. To access the 3-D tools, activate the Move tool, and you'll see all the 3-D tools at the end of the 
settings in the Options Bar. 

11. Reposition and scale each letter using the 3D tools or widgets. The letters will interact with each other 
by reflecting not just the Image Based Light but also each other once the 3D object is rendered (3-
D>Render). Even though you can manipulate each letter individually, they all still remain on a single 
3D layer. 

 
 

 

Summary: 

Assess student work using critique and self-evaluation methods. Additional question and answer sessions can 
help clarify technique and review project objectives. 

 

How does a 3-D layer differ from others in Photoshop? 

How can you change the camera view?  

How do you apply materials to an object? 

 

 

 

 

Performance 
Indicator 

 

1 

Falls Below 

 

2 

Approaches 

 

3 

Meets 

 

4 

Exceeds 

 
Dimension 

● Edges 
● Texture 

 

 
Type has no depth. 

 
Type is awkward and 
inconsistent in depth.  

 
Type appears to have 
consistent depth. 

 
Type is completely 
consistent, each letter has 
the same amount of depth. 

 
Lighting 

● Color  
● Value/form 

 
No consistent light source 
present. 

 
Inconsistent lighting, 
some letters do not 
follow light source 
pattern. 

 
Light source is properly 
employed to create a unified 
look. 

 
Light source creates 
convincing form and 
successful use of color. 

 
Conceptual 
Consistency 

● Creative 
● Problem solving 

 
Rarely shows coherency of 
the intended concept. 

 
Sometimes shows 
coherency of the 
intended concept. 

 
Shows coherency, but 
requires greater clarity of 
intended concept. 

 
Almost always shows 
coherency and clarity of 
intended concept. 
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UNIT V: INTRO TO ADOBE ILLUSTRATOR 

(appx. 3-4 weeks) 

Students will learn the key differences between the Adobe Photoshop and Illustrator platforms 
including file extensions and the main distinction of pixels vs. vector. 

Students will gain experience creating illustrator documents, adjusting the orientation and size 
using increments and begin to understand how Illustrators files can be endlessly manipulated to 
accommodate any print size without restriction or loss of quality. 

Students will begin to experience the difference between a vector and a pixel by creating and 
manipulating their own vectors and anchor points using basic tools in Adobe Illustrator. 

Overview: Key lessons for the Unit  

1. Introduction to Illustrator, Appearance Panel, Window, Toolbar, Zoom,  

2. The difference between Illustrator and Photoshop, Vectors vs. Pixels  

3. Introduction to geometric shapes and fills vs. strokes 
 

4. Introduction to basic drawing tools in illustrator 
o Differences between different drawing tools 
o Adjusting stroke thickness 

 
5. Introduction to modifying and anchor point tools 

 
6. Introduction to simple shapes  

      Identifying simple shapes within graphic design pieces and more complex forms 
 

7. Introduction to Type  tools 
o Horizontal vs. Vertical Type Tools 
o Type on a Path 
o Area Type tools 
o Expanding your type to convert it to Vector  

8. Creating layered imagery using a combination of simple shapes and drawing tools 
o Introduction to layers 

9. Exporting your Illustrator files to meet BMB specifications:  file type,size, resolution etc. 
o Using Art Boards to Save 
o Selecting dpi after exporting, etc. 
o  
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Objective 1 - Navigating Illustrator (appx. 1 day) 

 

● What is the difference between: Photoshop vs. Illustrator... Vector vs. Pixel  

● Introduction to the appearance panel, where tools and windows are located  

● How to switch between tools, move and zoom in and out within an artboard 

 

Tools Navigating Illustrator 

  

Hand (H) 

Moves the Illustrator artboard within the illustration window. 

● Click & drag to move around the document. 

 
 

Print Tiling Adjusts the page grid to control where artwork appears on the printed page. 

 
 

Zoom (Z) Increases and decreases the view magnification in the illustration window. 

 
 

Artboard 

Creates separate art boards for printing or export. 

●  Click & drag anywhere on the window to create a new art board. 
  

 

Suggested Activities: 

● Show examples of graphic arts made in Adobe Illustrator  

● Discuss appearance panel  

● Open templates  

● Create new documents for varying specifications  

● Adjusting Units and Increments: Resize documents  

● Changing Page Orientation  

● Workspace vs. Canvas 
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Resources: http://www.creativebloq.com/digital­art/illustrator­tutorials­1232697 

 

Objective 2 - Silhouettes, Shapes in Illustrator (appx.  2-3 Days) 

 

● What is the difference between paths, anchor points and handles  

● How to create paths and anchor points (See modify anchor point tools for instruction)  

● How to edit paths and anchor points (See modify anchor point tools for instruction)  

● What is the difference between open and closed shapes  

● What is a Stroke color vs. a Fill color and how to adjust it. 
o Double click on the fill color box to select a fill color 
o Double click on the stroke box to select a stroke color 
o Click once on the double arrow to switch between fill & stroke color  

● Introduce the color palette as well as: Fill color vs. Stroke Color and the no stroke Icon  

● Using smart guides to draw straight, parallel and perpendicular lines (see pen tools for instructions) 

Tools Basic Drawing in Illustrator 

  

Pen (P) Draws straight and curved lines to create objects. 

 

●  To create a straight line: Click and hold shift and 

click again 

 

●  To create a curve: Click to create anchor point then 

click and 

 drag to create a handle to determine an angle and amount of 

 curve 

 

●  To create a closed shape: Click at beginning anchor 

point 

 

●  Hold alt to break or modify anchor points to create 

sharp 

 corners 
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Pencil (N) Draws and edits freehand lines. 

 

●  Select the line, Click on the end anchor point and 

drag and 

 draw holding ALT to the opposite ending anchor point to close 

 the shape 

 

●  (You may also edit an existing geometric shape by 

selecting 

 the shape by dragging (drawing) the pencil near the shape’s 

 edge from starting anchor point to ending anchor point while 

 holding ALT to combine the two. 

 
 

Path Eraser Erases paths and anchor points from the object. 

 Click and swipe to erase or break up anchor points of an object (object 

 must be selected) 

 
 

Smooth Smooths Bezier paths. 

 
 

Line Segment (\) Draws individual straight line segments. 

 
 

Arc Draws individual concave or convex curve segments. 

 
 

Spiral Draws clockwise and counterclockwise spirals. 

  

● How to create curved lines (see pen, pencil & paint brush tools for instructions) 
● Basics of using the drawing table 
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Suggested Activities: Students may gain experience with the above tools and techniques by creating: 

● Using the pen tool create closed shapes such as clouds with smooth curves & sharp angles 
● Using the pen tool trace a silhouetted photographic image 
● File → Place to select and import an image 
  Then follow instructions for the pen tool 
● Using a variety of the above tools and techniques create:  

○  a simple graphic,  logo or icon to be used for segments of  BMB news reports: 
  Ie.  This Mepham Moment, Pirate Pride, Live from the Locker room, Behind the Desk, etc. 

 

Resources: 

https://helpx.adobe.com/illustrator/atv/cs6­tutorials/essentials­of­the­pen­and­pencil­tools.html 
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Objective 3 -  Modifying Anchor Points (appx. 3 days) 

 

● The difference between selection & direct selection tools  

● How and why to add or delete an anchor point in order to modify a path  

● Group, Magnetic, Lasso tool 
 

Tools Modifying Anchor Points 

  

The Selection tool 

(V) Selects entire objects. 

  Click on the object, shape or line to resize, move, and edit 

  

Direct Selection tool 

selects points or path segments within objects. Click on the object’s, 

shape 

(A) 

or line to select an anchor point to move the anchor point, adjust 

handles 

  

Add Anchor Point 

tool 

adds anchor points to paths Select the add an anchor point tool, then 

Click 

(+)  

to (add/subtract) an existing selected object in order to adjust the 

angle or 

  morph the shape in some way 

  

Delete Anchor Point 

deletes anchor points from paths Select the delete an anchor point 

tool, then 

tool (­) 

Click to (add/subtract) an existing selected object in order to adjust 

the 

  angle or morph the shape in some way 
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The Group Selection selects objects and groups within groups. 

tool  

  

The Magic Wand 

tool selects objects with similar attributes. 

(Y)  

  

The Lasso tool (Q) selects points or path segments within objects. 

  

   

Suggested Activities: 

 

● Live trace a simple icon and simplify given anchor points 
o File→ Place, select the placed object, Object→ Live Trace  

● Morph circles into stars, stars into circles 
 (See Add/Subtract Anchor points & Select/Direct 

selection tools for instruction)  

● Stretch, rescale simple geometric shapes into complex ones 

 

Resources: 

https://helpx.adobe.com/illustrator/using/selecting-objects.html 

 

 

 

 

 

 

 

https://helpx.adobe.com/illustrator/using/selecting-objects.html
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Objective 4 ­ Simple Shapes (appx. 2 days) 

 

● Key Commands for working with shapes  

○  Option Click to draw from the center point  

○  Space Bar Click and Drag to move object into position  

○  Option Click & Drag to duplicate a shape  

○  Shift & Drag to keep shapes in alignment  

○  Shift to select multiple objects  

○  Shift X to invert stroke vs. fill selections  

○  FWD Slash / to select No Fill  

● Experience with drawing simple shapes in illustrator  

● Using key commands to create concentric & perfect simple shapes  

○  Click and hold to select the specific shape click and drag to create a shape of a specific size or 
orientation.  

○  Hold SHIFT while creating a shape to make it an equilateral or “perfect” shape  

○  Hold ALT to create a concentric shape centered around the your crosshairs starting point.  

○  Making adjustments to simple shapes by adjusting anchor points and handles  

● Copying, Pasting, Duplicating simple shapes (key command review) CNTRL C, V, X, etc.  

● Arranging simple shapes (front to back) 
 

Tools Simple Shapes 

Rectangle tool (M) Draws squares and rectangles. 

Rounded Rectangle Draws squares and rectangles with rounded corners. 

Ellipse (L) Draws circles and ovals. 

Polygon Draws regular, multi-sided shapes 
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The Star tool Draws stars (Up arrow to add a point, Down arrow to delete a point 

 

Suggested Activities: 

 

● Create simple graphic to used as a logo for one of the BMB segments  

● Design the name of a BMB segment using a combination of simple geometric shapes 
 

 

 

Resources: 

https://helpx.adobe.com/illustrator/atv/cs6­tutorials/creating­objects­with­the­shape­tools.html 

 

 

Objective 5 -  Editing Simple shapes (appx. 1 week) 

● Combining, Rotating, Resizing and Transforming simple shapes to create complex shapes 
 

Suggested Activities: 

● Combine simple BMB logo graphics with your original segment name design using a combination of 

simple geometric shapes, then join/ simplify those shapes by merging (shape builder/pathfinder) into 

the fewest possible anchor points. 

 

Resources: 

 

https://helpx.adobe.com/illustrator/using/rotating­reflecting­objects.html 

 

https://www.youtube.com/watch?v=d7G4O1N2Q6g 

 

https://helpx.adobe.com/illustrator/using/creating­shapes­shape­builder­tool.html 

 

https://www.youtube.com/watch?v=LCb0shXPKeA 

https://helpx.adobe.com/illustrator/atv/cs6%C2%ADtutorials/creating%C2%ADobjects%C2%ADwith%C2%ADthe%C2%ADshape%C2%ADtools.html
https://helpx.adobe.com/illustrator/using/rotating-reflecting-objects.html
https://www.youtube.com/watch?v=d7G4O1N2Q6g
https://helpx.adobe.com/illustrator/using/creating-shapes-shape-builder-tool.html
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Objective 6 - Color Blends and Special Effects (appx. 1 week) 

 

● Using paintbrushes (and libraries) to create calligraphic lines using illustrator  

● Using the mesh, gradient tools to create light effects  

● Using the color guide to find perfect color harmonies, families  

● Using the blob tool to fill large areas of color while simplifying anchor points  

● Applying special effects drop shadows to objects and layers  

● Adding gradients to Strokes  

● Adding depth Drop Shadows, Bevels  

● Give Graphics a glossy shine  

● How to adjust lighting, layers and opacity 
 

 Painting tools 

  

Paintbrush (B) 

Draws freehand and calligraphic lines, as well as art, patterns, and 

bristle 

 brush strokes on paths 

  

 

Mesh (U) Creates and edits meshes and mesh envelopes. 

  

Gradient (G) 

Adjusts the beginning and ending points and angle of gradients 

within 

 objects, or applies a gradient to objects. 
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Blend tool (W) 

creates a series of objects blended between the color and shape of 

multiple 

 objects 

  

Eyedropper (I) 

Samples and applies color, type, and appearance attributes, 

including 

 effects, from objects. 

  

Flare Creates lens­flare or solar­flare­like effects. 

  

Live Paint Bucket (K) Paints faces and edges of Live Paint groups with the current paint 

 attributes. 

  

Live Paint Selection Selects faces and edges within Live Paint groups. 

(Shift­L)  

  

Blob Brush (Shift­B) 

Draws paths that automatically expand and merge calligraphic brush 

paths that share the same color and are adjacent in stacking order. 

  

  

 

Suggested Activities/ Exercises: 

 

● Create detailed 3 dimensional objects for BMB graphics and segments.  

 

Resources: 

 

http://design.tutsplus.com/articles/22­fun­gradient­mesh­tutorials­in­adobe­illustrator­for­beginners­­vect

or­22544 

 

http://www.creativebloq.com/illustrator/how­use­blob­brush­tool­71412405 

http://design.tutsplus.com/articles/22-fun-gradient-mesh-tutorials-in-adobe-illustrator-for-beginners--vector-22544
http://design.tutsplus.com/articles/22-fun-gradient-mesh-tutorials-in-adobe-illustrator-for-beginners--vector-22544
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ILLUSTRATOR – SAMPLE LESSONS 

Sample Lesson 1: Color Blending (appx. 1 week) 

Do Now: Gather around for a demonstration 

Aim: How can you merge multiple color/value gradients within one complex shape? 

Motivation: Up to this point you have had the ability to alter the color, tone of each object you create in 

illustrator. However we have only just begun to discuss the depth with which you can create lighting effects. 

Thanks to tools like the gradient, mesh and blend tools designers can achieve flawless transitions between 

colors, tones and complex shapes. Now we already have some experience with the gradient tool on its own 

selecting two or more colors within the gradient and choosing how slow or fast those transitions happen 

within a given object. However what if you wanted to apply multiple gradients along more complex shapes? 

While the Gradient tool allows you to create or modify a gradient fills and strokes by combining the gradient 

tool with the Blend tool, illustrator makes it possible to blend the shapes and colors of objects together into a 

new object with multiple gradations. 

 

Procedure: 

● Motivation  

● Demonstration of the Gradient & Blend tools  

1. Create a gradient fill.  

2. Apply and edit a radial gradient.  

3. Add colors to a gradient. 
4. Adjust the direction of a gradient blend.  

5. Blend the shapes of objects in intermediate steps.  

6. Create smooth color blends between objects.  

7. Modify a blend and its path, shape, and color.  

● Class time/work period: Recreate an organic image using the blob tool 
 

Review/Closure: What are some possible scenarios (subject matter) that might be necessary to use blends 

between multiple gradients? (portraits, anatomy, organic forms of any kind) 
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Assessment: 

 

● Q&A, during the process, & (1 on 1 during work period after)  

● The execution of their own organic image, caricature, portrait, etc.  

● Rubric or Reflection Sheet 
 

Sample Lesson 2: Paintbrush vs. the Blob tool (appx. 1 week) 

Do Now: Gather around for a demonstration 

Aim:  What are some ways we can we mimic the complex organic shapes seen here with Illustrator? 

 

Motivation: As you know Adobe Illustrator is a vector program, working in vector has a great many perks 

for the designer who can decide on a whim to change the scale dramatically. You know how to create strokes 

and closed shapes as well as manually combining geometric shapes. However, if I wanted to create an organic 

shape, ie: wispy clouds, grassy fields, this becomes much more difficult. 

 

● What are some ways we can we mimic the complex organic shapes seen here with Illustrator?  

Yes, it is possible we could draw individual strokes using a calligraphic setting on the paint brush however 
each stroke would then become individual paths without fill options. We could also use the shape builder tool 
however that tool requires you to individually create the simple shapes to combine complex ones. An 
alternative to this is the blob brush. The blob brush allows the artist to create organic shapes in a way that 
is similar to painting (a more natural gesture to the artist/painter) as one swipe of blob brush creates both a 
stroke and a fill at the same time. This allows for complex organic shapes to be created and edited very 
quickly. 

Procedure: 

● Motivation  

● Demonstration of the Blob tool  

● Class time/work period: Recreate an organic image using the blob tool 
 

Review/Closure: What are some ways that the blob tool differs from the shape builder or paintbrush tool? 

Assessment: 

 

● Q&A, during the process, & (1 on 1 during work period after)  
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● The execution of their own organic image  

● Rubric or Reflection Sheet 
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UNIT IX: TYPOGRAPHY / LOGO DESIGN (appx. 4 

weeks) 

Students will work collaboratively to conceive and develop a Logo design for a segment of a 

BMB Broadcasting segment  that successfully communicates the perceived value, meaning 

and concept of the segment. 

 

● The Propositional Principal & Logo unit will be based on the Design based project 

learning model. 

● Students create their own original logo designs that clearly communicate the value and 

meaning behind of their clients product. 

 

Overview:  

1. Introduction to Type tools in illustrator  

2. Differences between serif and sans serif and the anatomy of Typography:  

3. How to download and import & text via fontbook  

4. How to expanding text to create editable vectors  

5. Using precision grids to align visual elements creating balanced, proportional designs.  

6. Qualities of a successful Logo:  Simple, clear, deep meaning (not surface)  

7. Identify the propositional principal in existing logos (Fed Ex, Target, etc.)  

8. Students will be working within BMB segment specifications while designing logo 

variations that communicate positive qualities of their segment.  

9. Brainstorm and design creation of Logo  
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Objective 1 (appx. 1 week) 

● Using Type tools to create fully editable type  

● Discuss the differences between serif and sans serif  

● The anatomy of Typography:  

○  ascender, descender and base lines, bowl, shoulder, body, bracket, stem, loop, 
terminal, bracket, etc.  

● Importing & text via font book  

● Expanding text to be editable vectors 
 

 Type tools 

  

Type (T) Creates individual type and type containers and lets you enter and edit type. 

 
 

Area Type Changes closed paths to type containers and lets you enter and edit type 

 within them. 

 
 

Type On A Path Changes paths to type paths, and lets you enter and edit type on them. 

 
 

Vertical Type Creates vertical type and vertical type containers and lets you enter and edit 

 vertical type. 

 
 

Vertical Area Type Changes closed paths to vertical type containers and lets you enter and edit 

 type within them. 

 
 

Vertical Type On A Changes paths to vertical type paths and lets you enter and edit type on 

Path them. 



 

 

 

103 
 

 

  

 

Objective 2 (appx. 3-5 days) 

 

● Using Grids to align text and visual elements, creating a sense of order balance and proportion 
 

 Precision Tools 

  

Rectangular Grid Draws rectangular grids 

  

Polar Grid Draws circular chart grids 

  

Measure Measures the distance between two points. 

  

Perspective Grid Allows creating and rendering artwork in perspective. 

  

Perspective 

Selection 

Allows you to bring objects, text, and symbols in perspective, move 

objects in perspective, move objects in perpendicular to its current 

 direction. 

  

 

Suggested Activities/ Exercises: 

● Using the quote of your choice use type to illustrate the meaning of the phrase  

● Illustrate an action word 
● Create a personal Logo  

● How to design headline Typeface 
 

Projects/Assessments: 

● Client Design for Logo/ Poster/ Avatar/Character Design that meets a particular set of criteria 

and clearly conveys a particular concept 
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Resources: 

https://www.youtube.com/watch?v=xq8d3KtYWLo 

http://www.creativebloq.com/typography/column­grid­poster­design­made­neat­and­easy­10122682 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.youtube.com/watch?v=xq8d3KtYWLo
http://www.creativebloq.com/typography/column-grid-poster-design-made-neat-and-easy-10122682
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Sample Lesson 1: Introduction to Logo Design 

Motivation: 

 Introduction to the logo as design and the Propositional principal deeper meaning vs. surface meaning 

 

Materials:  Adobe Suite, Computers, Projector, paper, pen, pencil, 

 

Procedure: Students will brainstorm product/company associations that relate to the positive qualities of 

their                      clients product. 

1. Students experiment with combining words and images to design new imagery that may 

represent their client’s product. 

2. Students will thumbnail sketch their own original designs using their word & image 

association bank in an attempt to visually communicate their concept. 

3. Students will share and generate additional association lists and sketched thumbnail 

designs. 

4. After meeting with peers across the classroom, students will break into their own small 

group design teams and question which of their existing ideas are clearly communicating 

the best elements of their clients product and which designs use both propositional and 

surface based meaning.. 

 

Assessment: 

 

○  Students will narrow to the best 3 design concepts and then question and observe the strongest 

qualities of each design. (list)  

○  Based on the list they have developed, students will experiment with redesigning (at least 10 

variations) for each of the 3 design ideas for the client.  

○  Students will continue to evaluate and assess their designs and solidifying the concept and 

strongest design elements 

 
 

 

Worksheet/notes 
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INTRO TO ADOBE ILLUSTRATOR 

Vector Pixels 

  

 

File Formats 

 

AI PSD PDF JPG 

    

    

 

* YOU CANNOT “SAVE” FOR PRINT; YOU MUST EXPORT AND SELECT HIGH 300 PP 

(Not Screen or Medium) 

 

 

KEY SHORTCUTS 

 
Cntrl C 
 

 

 
Cntrl V 
 

 

 
Cntrl X 
 

 

 
Cntrl Z 
 

 

 
Cntrl T 
 

 

 
Cntrl + 
 

 

 
Cntrl – 
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Document 
Set Up 
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RUBRIC 
 
Name:_________________________________   Unit 
Objective:_____________________________ 
 
Briefly describe your concept/idea as well as the strengths and weaknesses of your 
design: 
 
____________________________________________________________

____________________________________________________________

____________________________________________________________

____________________________________________________________

____________________________________________________________ 

 

  Assignment 
     Criteria 

  Developing 
        0-69 

    Emerging 
       70-79 

    Proficient 
        80-89 

     Strong 
     90-100 

      Teacher 
    Comments 

Concept 
Appropriate look  
and feel for chosen 
event; eye catching 
imagery, color, and 
text  

No clear concept is 
developed; 
concept is 
developed but 
inappropriate to 
the assignment. 

Concept is original 
and somewhat  
clear; idea is  
appropriate to the 
assignment; some 
effort shown with  
color, imagery and 
content. 

Concept is clear and 
appropriate to the  
event; logical and  
pleasing use of color, 
imagery, and  
content to create an 
eye catching design 

The concept is very 
clear, exemplary 
effort in color use, 
imagery and  
content is used to 
create an exciting 
and successful  
design.  

 

 

Composition, 
Layout &  
Design 
 

Elements are 
confusing and 
scattered; there is  
little to no visual 
organization. 

There is some  
visual organization 
 but elements feel 
misaligned or out 
 of place.  

Shows clear visual  
order by use of the 
elements and  
principles of design  

Strong visual 
organization is  
used through the 
elements and 
 principles; visual 
 risks are taken to 
 create powerful and 
exciting imagery.   

 

 

Use of  
Illustrator  
proficiency at using 
Illustrator to create 
quality vector 
 artwork 

Does not have 
understanding of 
application 
 Program; no  
effort in using new 
skills, tools & 
techniques 

Some  
understanding of 
program but little 
effort displayed 
with new tools & 
techniques 

Good  
understanding of 
application program 
 with some 
experimentation / 
effort in the use of  
new skills, tools & 
techniques 

 

Excellent  
understanding of 
application  
program;  
advanced use of  
new skills, tools & 
techniques 

 

Following 
specifications  
Quality, print ready 
design prepared in a 
package folder 

Illustrator file not 
linked properly, 
incorrect color 
 mode, incorrect 
format and/or  
scale; package 
folder was not  
made correctly  

More than two of  
the criteria were  
not considered: 
-file format /linking 
-color mode 
-scale/format 
-package folder  

One or two of the 
 criteria were not 
considered: 
-file format / linking 
-color mode 
-scale/format 
-package folder  

All of the package 
criteria were met.  
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Art Direction  
& Critique  

Feedback/ 
Instructions were 
largely ignored.  

Some feedback/ 
instructions were 
taken into 
consideration. 

Most feedback/ 
instructions were 
represented in the 
completion of the 
design.  

A dialogue of  
feedback was  
created between 
 teacher, student & 
 peers;  work was 
analyzed critically,  
and the piece reflects 
thoughtful  
application of  
ongoing critique. 

 

 

  

 
Pathing a Low-Poly Butterfly 
For this formative, you will be pathing half of a geometric butterfly. You will then duplicate this half and reflect it to 
have one complete, symmetrical butterfly. Low Poly means there is a small number of polygons making up an entire 
image. They typically look very geometric. 
PART I 
1. Download the .jpg file from Google Classroom. To do this, right click on the image and open it in new tab. Press the 
download arrow and you will see it appear at the bottom once it downloads. 
2. Open Illustrator. From the File menu, select Open>Downloads> lowpoly.jpg. 
3. Open a New Layer. 
4. Select the pen tool. Set your fill color as no fill (red slash through foreground swatch) and your 
stroke color as black. 
5. Using the pen tool, create straight lines around the outside shape of the butterfly first. This 
includes the wing, body, and antenna. 
6. Next, path each of the designs on the inside of the wing. Once you have this finished, it should 
look something like this: 
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Low-Poly Wildlife Project 

       

 

For your next project, you are going to take the steps you used to create a butterfly and apply them to a low-

poly animal of your choice. Just like the butterfly, you are going to use your pen tool to create straight-edged, 

geometric polygons on HALF of a photo. Once all of your polygons have been outlined, you will fill them 

with color, and reflect a copy of your creation to finish the second half of your animal. 

Keys to Success 

 All of your paths must be complete before changing the stroke or fill color. Remember, we are 

working in terms of shapes. A set of incomplete lines are not a shape. 

 Take your time! 

 If you try to connect an anchor point of a new shape to one that is already active, it may delete the 

anchor point. To avoid this, hold down shift while clicking on an active anchor point in order to add to 

it. 

 Outline the animal’s silhouette FIRST, followed by any larger areas you would like to stay defined. 

This can include the eyes, nose, mouth, inside of the ears, and large patches of solid color. Then, fill in 

all smaller areas with polygons. 

 The more shapes you add, the more detail there will be at the end. 

 

Mastery Objectives 

Why are we making these? By the end of this project, you will have an understanding of how to use the pen 

tool to make geometric shapes. You are learning to manipulate Fill and Stroke color, Layers in Ai, Transform, 

and how vector graphics are created.  
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